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Introduction générale  



 

L’antenne joue un rôle primordial, elle est indispensable  pour établir n’importe quelle  

liaison entre deux points éloignés, que ce soit dans la téléphonie mobile, la radioastronomie, dans 

les systèmes de positionnements  par satellites (GPS), transmission des signaux TV et Radio, et 

dans les tours de contrôle des avions et les tours maritimes …etc, l’antenne est toujours présente 

et elle est vitale pour le bon fonctionnement de n’importe quel système de télécommunication. 

Chaque antenne est conçue pour être utilisée dans une application bien précise en tenant compte 

de ses paramètres de base.   

L’ensemble des chapitres s’organisent en partant des concepts fondamentaux de la théorie 

des antennes, caractéristiques des antennes: diagramme de rayonnement, directivité, gain, 

polarisation…etc, les notions fondamentales de l’électromagnétisme, et les différents types 

d'antennes. D’une extrémité à l’autre du spectre radioélectrique, les antennes ont des structures 

très différentes : 

Pylône verticaux en ondes kilométriques et hectométriques. 

Longs fils obliques ou horizontaux en ondes décamétriques. 

Réflecteurs et ouvertures rayonnante au delà de 1 GHZ et en ondes centimétriques et 

millimétriques. 

 Cependant, le rayonnement de ces antennes est étudié et caractérisé au moyen de 

définitions et propriétés communes qu’il est indispensable de connaitre, et ceci fait l’objet du 

premier chapitre. 

Et le second est consacré pour l’étude de l’antenne patch qui est utilisée lorsqu'on veut 

réduire l'encombrement d'une antenne, par exemple sur les émetteurs-récepteurs portables de 

radiocommunication, sur les récepteurs GPS. Vue que les générations des téléphones portables  

de cette décennie devient de plus en plus fin, autrement dit une technologie de pointe, ce qui 

lance une robuste course vers la miniaturisation des antennes (PIFA). 

  De nos jours les études et les recherches sur le domaine des antennes sont très évoluées,  

que ce soit sur le plan théorique ou pratique, ce qui veut dire l’établissement de nouvelles 

conceptions ; le but principal des chercheurs est de les miniaturiser tout en gardant leurs 

propriétés voir même les optimiser. Pour économiser les ressources destinées à la conception, on 

fait appel à la simulation électromagnétique (EM) qui est un outil essentiel dans la conception 

moderne des filtres et des antennes. Les techniques de simulation EM ont évolués rapidement 

pour atteindre un niveau de précision très important. Ces outils de simulation ont permis 

d'accélérer le processus de conception, permettant de concevoir des prototypes virtuels. On prend 

comme exemple le logiciel HFSS (High Frequency Structure Simulation) qui est  l’un des plus 

performants sur le marché, ses fonctionnalités sont présentées dans notre troisième chapitre. 

Le quatrième chapitre est destiné à la partie applications où on simulera  divers types 

d’antennes telles que le dipôle, antenne cornet, antenne résonateur, deux exemples du patch 

rectangulaire alimentés par deux méthodes : ligne microruban, et par un câble coaxial, antenne 

patch avec un élément rayonnant triangulaire à fente.  

Enfin nous terminerons par une conclusion générale récapitulative.  
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I-1.Introduction  
 

Le but de ce chapitre est de comprendre le principe 
Le chapitre est orienté de la manière suivante
notions de base d’électromagnétisme afin de mieux comprendre le principe de 
fonctionnement, la seconde partie sur les 
(impédance d’entrée, diagramme de rayonnement, gain..
principaux types d’antennes (dipôles, cornet
 
I-2Définition d’une antenne 
 

Une antenne en réalité 
approprié à l’électronique nous dirons
recevoir des ondes électromagnétiques. En d'autres termes, c'est une structure transitoire entre 
l'espace libre et un dispositif guidant.
ou un guide d'onde. Il sert à transmettre l'énergie d'une source vers l'antenne ou de l'antenne 
vers un récepteur. 
En simplifiant on dit qu’un conducteur électrique
sous forme de chaleur, de lumière (lampe).
du transformateur) et électrique (principe 
d'émission est de faire en sorte que lorsqu’elle est parcourue pa
chauffer ni s'illuminer, va créer 
tour un champ électrique et ain
Ce champ se propage, c'est alors une ond
Une onde électromagnétique se transforme en énergie électrique
électrique, c’est  le principe de l'antenne de réception qui 
électromagnétique de l'air soit transformé en é
 
I-2-1.Rôle de l’antenne  
Voici un système de communication radio qui transmet des 
d’une onde électromagnétique (OEM).
 
 

  
                 Figure I-1 : Un syst
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Le but de ce chapitre est de comprendre le principe de fonctionnement des antennes
orienté de la manière suivante: la première partie revient sur la défin

d’électromagnétisme afin de mieux comprendre le principe de 
seconde partie sur les caractéristiques principales d’une 
diagramme de rayonnement, gain.. puis nous terminerons

ypes d’antennes (dipôles, cornet, antenne patch, ouverture rayonnante …).

  

Une antenne en réalité est un bout de métal, ou un diélectrique ; avec un langage plus 
nous dirons que c’est un dispositif métallique qui sert à rayonner ou 

recevoir des ondes électromagnétiques. En d'autres termes, c'est une structure transitoire entre 
l'espace libre et un dispositif guidant. Le dispositif guidant peut être une ligne de transmission 
ou un guide d'onde. Il sert à transmettre l'énergie d'une source vers l'antenne ou de l'antenne 

n dit qu’un conducteur électrique parcouru par un courant, fournit
, de lumière (lampe).De même il fournit un champ magnétique (principe 

mateur) et électrique (principe du condensateur). Le principe de l'antenne 
d'émission est de faire en sorte que lorsqu’elle est parcourue par un courant variable, sans 

auffer ni s'illuminer, va créer  un champ magnétique variable autour et ce dernier crée 
et ainsi de suite (c’est la description des équations de Maxwell).

Ce champ se propage, c'est alors une onde électromagnétique. 
électromagnétique se transforme en énergie électrique guidée grâce à un conducteur 

ipe de l'antenne de réception qui est de faire en sorte que le champ 
électromagnétique de l'air soit transformé en énergie utilisable (signal électrique).

ème de communication radio qui transmet des informations 
e onde électromagnétique (OEM).  

système de communication radio par (OEM). 
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r un courant variable, sans 
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est de faire en sorte que le champ 
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informations par l’intermédiaire 
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L’antenne d’émission reçoit le signal électrique de l’émetteur et produit l’onde 
électromagnétique. 
Cette OEM se propage dans l’espace autour de l’antenne d’émission en fonction du type et de 
la forme d’antenne utilisée, certaines directions de propagation peuvent être privilégiées. 
La puissance produite par l’émetteur ou appliquée à l’antenne se disperse dans l’espace. 
L’antenne de réception capte une faible partie de cette puissance et la transforme en signal 
électrique. 
 
I-2-2.Courant dans une antenne  
 
Pour le courant dans le brin (antenne) : 
L’émetteur produit une porteuse sinusoïdale modulée à la fréquence f qui est conduite à 
l’antenne par un câble coaxial. 
L’antenne est alors parcourue par un courant i(t) ayant les caractéristiques suivantes : 
Le courant i(t) est sinusoïdal à la fréquence de la porteuse. 
Le courant n’a pas la même intensité en tout point. 
Ce courant peut occasionner des pertes Joule si les matériaux utilisés sont de mauvaise 
qualité. Alimentée par la tension v(t) et absorbant un courant i(t), l’antenne présente donc une 
impédance équivalente Za. 
Cette impédance dépend toujours de la fréquence, elle est résistive pour certaines longueurs 
uniquement. 
Pour que toute la puissance fournie par l’émetteur soit rayonnée, il faut adapter le câble en 
sortie, ce qui supprime l’onde réfléchie. 
Souvent le câble a une impédance Zc = 50 ohms, on s’efforce donc de fabriquer des antennes 
d’impédance d’entrée de 50 ohms. 
 

 
 
               Figure I- 2 : Illustration de l’intensité du courant dans un brin. 
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Le courant qui circule dan
électromagnétique : 
L’OEM est constituée d’un champ électrique E et d’un champ magnétique B
Les vecteurs E et B existent en tout point M autour de l’antenne et oscillent au rythme du 
courant et donc de la porteuse.
Leur module n’est pas le même partout et dépend du type d’antenne utilisé
du point de mesure. 
 
I-3.Notions sur l’électromagnétisme
Le but est de revenir sur certaines notions fondamentales d’électromagnétisme avant de se 
concentrer sur les antennes. Il s’agit de répondre aux questions suivantes : pourquoi une 
antenne rayonne ? Qu’est-ce qu’une onde électromagnétique ?
 
I-3-1.Les charges électriques
 Les charges électriques au repos peuvent exercer des forces électriques entre elles, 
cette action à distance se fait par l’intermédiaire d’un champ électrique. Tou
électrique Q immobile créé un champ électrique E dans l’espace environnant, qui décroit 
inversement avec le carré de la distance.
On peut assimiler ça à la force de gravitation qui 
déplacer dans une direction bien précise.

                 

   
I-3-2.Le Champ magnétique
 
Toute circulation de courant (c'est
champ magnétique tournant autour de la ligne. 
toute autre interconnexion parcourue par un courant.
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Le courant qui circule dans le brin rayonnant produit à son voisinage une onde 

d’un champ électrique E et d’un champ magnétique B
vecteurs E et B existent en tout point M autour de l’antenne et oscillent au rythme du 

courant et donc de la porteuse. 
module n’est pas le même partout et dépend du type d’antenne utilisé

otions sur l’électromagnétisme  
Le but est de revenir sur certaines notions fondamentales d’électromagnétisme avant de se 
concentrer sur les antennes. Il s’agit de répondre aux questions suivantes : pourquoi une 

ce qu’une onde électromagnétique ? 

es charges électriques  
Les charges électriques au repos peuvent exercer des forces électriques entre elles, 

à distance se fait par l’intermédiaire d’un champ électrique. Tou
un champ électrique E dans l’espace environnant, qui décroit 

inversement avec le carré de la distance. 
On peut assimiler ça à la force de gravitation qui exerce une force sur les objets 

direction bien précise.   

                                  ( )E r u
����� ���

Le Champ magnétique  

oute circulation de courant (c'est-à-dire des charges en mouvement) est à l’origine d’un 
champ magnétique tournant autour de la ligne. Cette ligne exercera une force à distance sur 
toute autre interconnexion parcourue par un courant.  

                                0
( )

( ) ( )
( )

4

J P u P
B M dτ

µ
π
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Le but est de revenir sur certaines notions fondamentales d’électromagnétisme avant de se 
concentrer sur les antennes. Il s’agit de répondre aux questions suivantes : pourquoi une 

Les charges électriques au repos peuvent exercer des forces électriques entre elles, 
à distance se fait par l’intermédiaire d’un champ électrique. Toute charge 

un champ électrique E dans l’espace environnant, qui décroit 

exerce une force sur les objets pour les 
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Pour bien comprendre ce phénomène on fait appel à l’expérience d'Œrsted qui le vérifie.  
Tout déplacement de charges, que ce soit un faisceau d'électrons dans le vide ou un courant 
électrique dans un fil crée un champ magnétique. 
L'expérience d'Œrsted  démontre que la circulation d'un courant dans un fil fait dévier 
l'aiguille d'une boussole placée à proximité. 
La direction du champ magnétique (B) est celle d'une aiguille au point considéré et son sens 
est du pôle Sud vers le pôle Nord de l'aiguille aimantée. 
Son intensité dépend du courant qui crée le champ, mesurable avec un Teslamètre à sonde de 
Hall, et s'exprime en Teslas (T). 

Un fil rectiligne, dans le vide (ou dans l'air) crée un champ B en Teslas égal à : 0 2 .T

I
B

r
µ

π
=

Ou µ0 est la perméabilité du vide, I  l'intensité du courant en Ampères et r  le rayon en mètres 
de la ligne de champ. 
       

                  

 

La règle de la main droite 

Pour un conducteur, le pouce dans le sens du courant, les doigts s'enroulent dans le sens du 
champ. Pour une bobine, les doigts s'enroulent dans le sens du courant et le pouce pointe vers 
le Nord. 
  
I-3-3.Le rayonnement électromagnétique 
 

Les charges électriques et les courants constituent donc les sources élémentaires des 
champs électromagnétiques. Les deux cas précédents correspondent au cas où les charges sont 
immobiles (électrostatique) et les courants continus (magnétostatique), qui conduisent à des 
champs constants dans le temps. Cependant, l’action d’une charge ou d’un courant n’est pas 
instantanée mais retardée par un temps t = r/c, où c est la vitesse de la lumière. 
Ainsi, tout mouvement de charges ou toute variation de courant induira une variation de 
champ électrique ou magnétique en un point donné de l’espace après un temps de retard 
donné. Bien qu’en électrostatique et en magnétostatique les champs électriques et 
magnétiques soient indépendants, cela n’est plus le cas dès que la quantité de charge ou le 
courant varient. Les champs électriques et magnétiques sont alors liés. On parle alors de 
champ électromagnétique. 
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Comprendre l’origine du rayonnement électromagnétique
 

Toute charge et tout mouvement de charge sont capables de créer des champs 
électriques et magnétiques autour d’eux et devraient être capables de produire
rayonnement électromagnétique. Cependant, dans la
rayonnent pas. En effet, la plupart des objets contiennent des
équilibre, si bien que les champs électriques que chacune de ces
Lorsqu’un courant circule le long d’une interconnexion, les charges
s’accumulent pas au bout de l’interconnexion, mais reviennent par un autre chemin,
ainsi une boucle. 
Ainsi, le champ magnétique créé par 
contribution des autres et annulent quasiment le champ magnétique total à grande

 
Alors comment une antenne fait

Intuitivement, on sent qu’il faut qu’il y
les courants parcourant l’antenne, par exemple
courant ou toute discontinuité dans l’antenne conduisant à
pour empêcher l’annulation de la cont
courant de l’antenne. Dans l’exemple suivant, un courant continu se
boucle carrée à t = 0.  
Bien que les contributions des deux côtés de la boucle
identiques en amplitude et de signe inverse, la contribution de l’élément
un peu avant celle de l’élément 2 (ou les contributions des deux éléments sont
permettant la création d’un rayonnement électromagnétique pendant un t
maintenant un courant variable se met à parcourir la boucle, un rayonnement 
électromagnétique sera produit continuellement.
 
 

 
Figure I-3 : Rayonnement EM
taille. 
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rayonnement électromagnétique  

Toute charge et tout mouvement de charge sont capables de créer des champs 
magnétiques autour d’eux et devraient être capables de produire

rayonnement électromagnétique. Cependant, dans la nature, quasiment tous les objets ne 
rayonnent pas. En effet, la plupart des objets contiennent des charges positives et négatives en 
équilibre, si bien que les champs électriques que chacune de ces charges génèrent s’annulent. 
Lorsqu’un courant circule le long d’une interconnexion, les charges
s’accumulent pas au bout de l’interconnexion, mais reviennent par un autre chemin,

Ainsi, le champ magnétique créé par chaque élément de cette boucle s’additionne avec la 
contribution des autres et annulent quasiment le champ magnétique total à grande

Alors comment une antenne fait-elle pour rayonner ? 
Intuitivement, on sent qu’il faut qu’il y ait un déséquilibre dans la distribution de charges et 
les courants parcourant l’antenne, par exemple produit par toute variation temporelle du 
courant ou toute discontinuité dans l’antenne conduisant à une accumulation de charges. Ceci 
pour empêcher l’annulation de la contribution de chaque charge et de chaque élément de 
courant de l’antenne. Dans l’exemple suivant, un courant continu se met à parcourir une petite 

Bien que les contributions des deux côtés de la boucle (notés éléments 1 et 2) soient 
dentiques en amplitude et de signe inverse, la contribution de l’élément 1 de l’antenne arrive 

un peu avant celle de l’élément 2 (ou les contributions des deux éléments sont
permettant la création d’un rayonnement électromagnétique pendant un t
maintenant un courant variable se met à parcourir la boucle, un rayonnement 

produit continuellement. 

EM créé par la variation d’un courant dans un circuit de petite 
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Toute charge et tout mouvement de charge sont capables de créer des champs 
magnétiques autour d’eux et devraient être capables de produire un 

nature, quasiment tous les objets ne 
charges positives et négatives en 

rges génèrent s’annulent. 
Lorsqu’un courant circule le long d’une interconnexion, les charges véhiculées ne 
s’accumulent pas au bout de l’interconnexion, mais reviennent par un autre chemin, formant 

s’additionne avec la 
contribution des autres et annulent quasiment le champ magnétique total à grande distance. 

e dans la distribution de charges et 
produit par toute variation temporelle du 

une accumulation de charges. Ceci 
de chaque élément de 

met à parcourir une petite 

(notés éléments 1 et 2) soient 
1 de l’antenne arrive 

un peu avant celle de l’élément 2 (ou les contributions des deux éléments sont déphasées), 
permettant la création d’un rayonnement électromagnétique pendant un temps très bref. Si 
maintenant un courant variable se met à parcourir la boucle, un rayonnement 

 

créé par la variation d’un courant dans un circuit de petite 
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 On peut donc voir le rayonnement électromagnétique comme la résultante des 
différences de phase des contributions de chaque élément de l’antenne. 
On ne peut pas parler d’électromagnétisme sans parler des équations de Maxwell. 
 
I-3-4. Bibiographie sur James Clerk Maxwell  

James Clerk Maxwell (13 juin 1831 à Édimbourg, en Écosse - 5 novembre 1879) est 
un physicien et mathématicien écossais. Il est principalement connu pour avoir unifié en un 
seul ensemble d'équations, les équations de Maxwell, l'électricité, le magnétisme et 
l'induction, en incluant une importante modification du théorème d'Ampère. Ce fut à l'époque 
le modèle le plus unifié de l'électromagnétisme. Il est également célèbre pour avoir interprété, 
la lumière comme étant un phénomène électromagnétique en s'appuyant sur les travaux 
de Michael Faraday. Il a notamment démontré que les champs électriques et magnétiques se 
propagent dans l'espace sous la forme d'une onde et à la vitesse de la lumière. 
Ces deux découvertes permirent d'importants travaux ultérieurs notamment en relativité 
restreinte et en mécanique quantique. 
Il a également développé la distribution de Maxwell, une méthode statistique de description 
de la théorie cinétique des gaz. 
Maxwell est considéré par de nombreux physiciens comme le scientifique du XIX

e siècle ayant 
eu le plus d'influence au XX

e siècle. Ses contributions à la science sont considérées par 
certains comme aussi importantes que celles d'Isaac Newton ou d'Albert Einstein. 
En 1931, pour le centenaire de la naissance de Maxwell, Einstein lui-même décrivait les 
travaux de Maxwell comme les « plus profonds et fructueux que la physique ait connu depuis 
le temps de Newton ». 
Il est également connu pour avoir réalisé la première photographie en vraie couleur en 1861. 
 
I-3-5. Equations de Maxwell  
 
Toute l’électromagnétisme est contenue dans les équations de Maxwell .La présentation des 
équations de Maxwell permet de donner un cadre un peu plus mathématique à la discussion 
précédente. En réalité ces équations sont des postulats qui veut dire qu’elles ne se démontrent 
pas. 
I-3-5-1.Présentation des équations de Maxwell  
 

La répartition des champs électriques et magnétiques dans l’espace produite par une 
Distribution donnée de charges et de courants peut être déterminée en résolvant les équations 
de Maxwell. En outre, celles-ci permettent de déterminer comment l’onde électromagnétique 
se propage dans l’espace. Pour un milieu homogène et isotrope (cas général de la propagation 
en espace libre ou guidée), celles-ci sont données par les équations ci-dessous : 
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L’équation de Maxwell-Gauss-électrique :divE
ρ
ε

=
�

 (eq1) 

L’équation de Maxwell-Gauss-magnétique : 0divB=
�

 (eq2) 

L’équation de Maxwell-Faraday : 
H

rotE
t

µ ∂= −
∂

�
��

   (eq3) 

L’équation de Maxwell-Ampère :
E

rotH E
t

σ ε ∂= +
∂

�
� ��

  (eq4) 

Avec : 
ρ : densité volumique de charge (c/m). 

ε  : Permittivité électrique (F/m). A noter 0ε permittivité diélectrique dans le vide (8.85.10-12) 

rε : Permittivité électrique relative telle que ε  = 0ε × rε . 

µ : perméabilité magnétique (H/m). A noter µ0: permittivité diélectrique dans le vide (4π.10-7)     

µr : permittivité magnétique relative telle que µ = 0µ × µr. 

 
 
I-3-5-2. L’équation de Maxwell-Gauss-électrique   

Issue du théorème de Gauss, elle indique que toute distribution de charges dans 
l’espace conduit à l’apparition d’un champ électrique, de telle sorte que pour tout volume 
contenant ces charges, le flux du champ électrique sortant de cette surface est proportionnel à 
somme algébrique de toutes les charges intérieures. 
 
I-3-5-3.L’équation de Maxwell-Gauss-magnétique 

 
Indique qu’un courant induit un champ magnétique qui forme une boucle autour de ce 

courant. Contrairement au champ électrique créé par une charge, le flux de champ magnétique 
sortant de toute surface fermée est nul.  

Comparant cette équation avec celle de Maxwell-Gauss, on peut en conclure qu’il n’y 
a pas de charges magnétiques analogues aux charges électriques. 
    
I-3-5-4. L’équation de Maxwell-Faraday  

Elle est issue de la loi de Faraday et décrit le phénomène d’induction d’une force 
électromotrice par un champ magnétique variable. Le flux d’un champ magnétique variable à 
travers toute surface incluse à l’intérieur d’un contour fermé donne naissance à une force 
électromotrice. 
    
I-3-5-5.L’équation de Maxwell-Ampère 
 

Elle permet de relier le champ magnétique au courant circulant dans un circuit. Elle est 

issue de la loi d’Ampère crotE J=
����� ��

 qui relie le champ magnétique et le courant de conduction

cJ Eσ=
�� ��

. Il s’agit du flux d’électrons apparaissant dans un conducteur 
Électrique entre chaque molécule lorsqu’on le soumet à une force électromotrice.  
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Cependant, cette équation n’est pas suffisante pour expliquer l’existence d’un courant 
alternatif dans un circuit comprenant un c
armature d’un condensateur ne permet
celui-ci. Cependant, sous l’influence du champ
armatures chargées du conde
armatures. Ce flux de charge en mouvement est appelé

D

E
J

t

δε
δ

=
��

���
. 

 
I-3-6.Interprétation du rayonnement EM d’après les équations de Maxwell

 
Que se passe t-il lorsqu’un courant de conduction variable du temps traverse un fil

(antenne) ; D’après l’équation
au voisinage de ce fil. Localement
magnétique qui, d’après l’équation de
électrique variable. Localement, cette variation de
champ magnétique et ce processus 
magnétiques se propagent conjointement à l’image d’une vague. La
de Maxwell montre que la vitesse de déplacement des champs est une
vitesse de la lumière la célérité

 

 
         
                            Figure I-4 : Propagation  des ondes électromagnétique
 
 Voila un schéma plus familier
 
 

 
 

Chapitre I : Généralités sur les antennes

8 

équation n’est pas suffisante pour expliquer l’existence d’un courant 
comprenant un condensateur. L’isolant présent entre chaque 

armature d’un condensateur ne permet pas la présence d’un courant de conduction à travers 
ci. Cependant, sous l’influence du champ électrique variable apparaissant entre les deux

armatures chargées du condensateur, la variation de charge est identique sur les deux
armatures. Ce flux de charge en mouvement est appelé densité de courant de 

du rayonnement EM d’après les équations de Maxwell

il lorsqu’un courant de conduction variable du temps traverse un fil
; D’après l’équation Maxwell-Ampère, un champ magnétique variable est produit 

au voisinage de ce fil. Localement autour de ce point, il y a une variation du flux du cham
magnétique qui, d’après l’équation de Maxwell-Faraday, va donner naissance à un champ 
électrique variable. Localement, cette variation de champ électrique donne naissance à un 
champ magnétique et ce processus continu de proche en proche. Les champs élect
magnétiques se propagent conjointement à l’image d’une vague. La résolution des équations 
de Maxwell montre que la vitesse de déplacement des champs est une constante c égale à la 

la célérité. 

 

Propagation  des ondes électromagnétiques. 

Voila un schéma plus familier : 
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équation n’est pas suffisante pour expliquer l’existence d’un courant 
ondensateur. L’isolant présent entre chaque 

pas la présence d’un courant de conduction à travers 
ariable apparaissant entre les deux 

est identique sur les deux 
courant de déplacement

du rayonnement EM d’après les équations de Maxwell 

il lorsqu’un courant de conduction variable du temps traverse un fil 
Ampère, un champ magnétique variable est produit 

autour de ce point, il y a une variation du flux du champ 
Faraday, va donner naissance à un champ 

champ électrique donne naissance à un 
proche. Les champs électriques et 

résolution des équations 
constante c égale à la 
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 I-3-7.Rayonnement électromagnétique d’une source électrique  
 

Les courants et les charges sont les sources primaires du champ électromagnétique. 
Selon le principe de Huygens, elles rayonnent dans l’espace, des ondes sphériques dont la 

propagation est en fonction de exp( )jkr

r

− .Ainsi, tout courant I0 créé un rayonnement 

proportionnel à I0
exp( )jkr

r

− et  chaque charge Q0 un rayonnement proportionnel à Q0 

exp( )jkr

r

−
. 

Il est possible d’exprimer la contribution de toute source primaire caractérisée par une 
distribution volumique de courant I(p) et de charge Q(P) en un point M par les potentiels 
scalaires V et vecteur A. 
 

( )

exp( )
( ) ( )

4

jkr
A M J P d

rτ
µ τ
π

−= ∫∫∫
���

 (eq5) 

( )

exp( )
( ) ( )

4

jkr
V M P d

rτ
µ ρ τ
πε

−= ∫∫∫
���

 (eq6) 

 
A partir de ces potentiels, il est possible de calculer les champs électriques et magnétiques en 
Tout point de l’espace :   

A
E gradV

t

δ
δ

= − −
��

�� ��������
( eq7) 

                                                         
1

H rotA
µ

=
��� �����

  (eq8) 

 
I-3-8. Les Equations de propagation du champ E et H 
 

La résolution des équations de Maxwell va nous permettre de déterminer l’équation de 
Propagation des champs. Nous ne considérerons ici que le cas d’un milieu de propagation 
sans pertes caractérisé par une constante diélectrique et magnétique réelle, où il n’y a donc 
aucune charge et courant. En combinant alors les équations de Maxwell-Ampère et de 
Maxwell-Faraday, il est possible d’écrire les deux équations différentielles dites de 
propagation : 
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Les solutions à ces deux équations se comportent comme des ondes qui se propagent à la 

vitesse 1
v

ε µ
=

×
.Dans le vide ou dans l’air, cette vitesse est notée c et est égale 

8

0 0

1
3.10 /c m s

ε µ
= =

×
. 

De manière générale, la vitesse peut s’écrire  

électrique relative Ɛr et la perméabilité magnétique relative du milieu µr.
propage est appelée onde progressive.
 
 I-4.Modèle électrique et comportement fréquentiel
  Une antenne rayonne efficacement sur une bande de fréquence étroite qui correspond à 
sa fréquence de résonance. Lorsqu’un signal variable excite une antenne, des charges sont mis 
en mouvement le long de l’antenne d
La résonance correspond à une situation où ces charges sont en oscillation permanente. Pour 
représenter ce comportement résonant qui varie avec la fréquence, il est possible de modéliser 
l’antenne par un circuit passif  
 
Modèle électrique d’une antenne
On peut résumer le comportement de l’antenne passive (qui représente un comportement 
linéaire), comme une antenne 
d’énergie sous forme d’énergie électrique), s’oppose aux variations des courants qui y 
circulent (comportement inductif = stockage sous forme d’énergie magnétique) et dissipe une 
partie de l’énergie (pertes ohmiques et par rayonnement). D’un point de vue électrique
antenne passive peut donc être modélisée par un circuit équivalent RLC 
la figure I-5; et l’impédance Zin vue à
dessous. A noter que les valeurs du modèle ne sont valides

                  Figure I-5 modélisation d’une antenne par circuit RLC
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2

2
0

E
E

t
εµ ∂∆ − =

∂

�
��

 (eq9) 

                                                          
2

2
0

H
H

t
εµ ∂∆ − =

∂

�
��

 (eq10) 

Les solutions à ces deux équations se comportent comme des ondes qui se propagent à la 

Dans le vide ou dans l’air, cette vitesse est notée c et est égale 

De manière générale, la vitesse peut s’écrire  
r r

c
v

ε µ
=

×
  en fonction de la permittivité 

et la perméabilité magnétique relative du milieu µr.
propage est appelée onde progressive. 

électrique et comportement fréquentiel  
Une antenne rayonne efficacement sur une bande de fréquence étroite qui correspond à 

fréquence de résonance. Lorsqu’un signal variable excite une antenne, des charges sont mis 
mouvement le long de l’antenne donnant naissance à un rayonnement.  

correspond à une situation où ces charges sont en oscillation permanente. Pour 
comportement résonant qui varie avec la fréquence, il est possible de modéliser 

circuit passif  RLC équivalent. 

odèle électrique d’une antenne  
mportement de l’antenne passive (qui représente un comportement 

une antenne qui stocke des charges (comportement capacitif = stockage
sous forme d’énergie électrique), s’oppose aux variations des courants qui y 

circulent (comportement inductif = stockage sous forme d’énergie magnétique) et dissipe une 
partie de l’énergie (pertes ohmiques et par rayonnement). D’un point de vue électrique
antenne passive peut donc être modélisée par un circuit équivalent RLC comme illustré 

et l’impédance Zin vue à l’entrée de l’antenne est donnée par l’équation ci 
. A noter que les valeurs du modèle ne sont valides que sur des bandes étroites.

5 modélisation d’une antenne par circuit RLC 
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Les solutions à ces deux équations se comportent comme des ondes qui se propagent à la 

Dans le vide ou dans l’air, cette vitesse est notée c et est égale à

en fonction de la permittivité 

et la perméabilité magnétique relative du milieu µr. Une onde qui se 

Une antenne rayonne efficacement sur une bande de fréquence étroite qui correspond à 
fréquence de résonance. Lorsqu’un signal variable excite une antenne, des charges sont mis 

 
correspond à une situation où ces charges sont en oscillation permanente. Pour 
comportement résonant qui varie avec la fréquence, il est possible de modéliser 

mportement de l’antenne passive (qui représente un comportement 
stocke des charges (comportement capacitif = stockage 

sous forme d’énergie électrique), s’oppose aux variations des courants qui y 
circulent (comportement inductif = stockage sous forme d’énergie magnétique) et dissipe une 
partie de l’énergie (pertes ohmiques et par rayonnement). D’un point de vue électrique, une 

comme illustré dans 
nne est donnée par l’équation ci 

es bandes étroites. 
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I-5. La longueur d’onde  
 

A un instant donné, la répartition des champs le long d’un axe est sinusoïdale, et la 
distance entre deux maxima est la longueur d’onde
La longueur d’onde est liée à la fréquence f de la porteuse par 
Avec c=3.108 m/s=300000km/s
   
E et B sont deux ondes progressives :

  
 
                 Figure I-6: Représentation de la longueur d’onde
I-6. Les notions d’ondes  
 
L'onde plane est un concept issu de la physique de la 
dont les fronts d'onde sont des 
propagation désignée par le vecteur

Onde monochromatique  

Une onde est monochromatique lorsqu'elle ne contient qu'une 
fréquence ou, exprimé autrement, une seule pulsation

chaque point une amplitude de forme 
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A un instant donné, la répartition des champs le long d’un axe est sinusoïdale, et la 
est la longueur d’onde : 

La longueur d’onde est liée à la fréquence f de la porteuse par : λ = c/ f 
m/s=300000km/s 

E et B sont deux ondes progressives :         

: Représentation de la longueur d’onde 

est un concept issu de la physique de la propagation des ondes
sont des plans infinis, tous perpendiculaires à une même direction de 

vecteur n
�

. 

Une onde est monochromatique lorsqu'elle ne contient qu'une couleur, c'est
ment, une seule pulsation 2 fω π= . Une telle onde plane a en 

chaque point une amplitude de forme sinusoïdale comme fonction du temps:

: Généralités sur les antennes 2013 

 

 

A un instant donné, la répartition des champs le long d’un axe est sinusoïdale, et la 

 

propagation des ondes. C'est une onde 
infinis, tous perpendiculaires à une même direction de 

, c'est-à-dire une seule 
. Une telle onde plane a en 

comme fonction du temps: 
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( , ) cos( . )u r t a k r tω= −
�� �

 

Où k
�

 est  le vecteur d'onde  
ω est la pulsation  

( , , )r x y z=� est le vecteur position 

 a  est l'amplitude complexe de l'onde. 
Ce type d'onde est particulièrement utile en physique car il est simple à utiliser, cette dernière  
est une bonne approximation de nombreuses ondes. En particulier, lorsque l'on est assez loin 
d'une source d'onde ponctuelle (un laser, une antenne de radio de petite taille) les ondes 
sphériques concentriques émises par un tel dispositif sont bien approchées localement par une 
onde monochromatique plane. Cependant il n'existe pas rigoureusement d'ondes planes 
purement monochromatiques dans la nature car celles-ci devraient transporter une énergie 
infinie, ce qui est impossible. 

En pratique  
 Même si une onde plane pure n'existe pas dans la nature, il est possible de s'en 
approcher dans un domaine limité de l'espace. Il suffit que les fronts d'onde soient 
suffisamment plans et parallèles dans le volume considéré. De plus, une onde plane est 
rarement monochromatique, car elle aurait une extension temporelle infinie. 
Une onde réelle peut cependant être décomposée en ondes planes monochromatiques, dont les 
vecteurs d'onde sont parallèles à une seule et même direction : 

( . )( , ) ( , ) i k r tu r t a k e dkdωω ω−= ∫
� ���

 

où ( , )a k ω
�

est une fonction à valeurs complexes appelée spectre d'ondes planes. 

Cette superposition d'ondes planes monochromatiques permet de décrire toute onde réelle. 
Pour obtenir une onde plane, on peut par exemple faire passer de la lumière par un 
diaphragme puis la collimater avec une lentille convergente. 
 
L’onde plane  

Si on se trouve dans une zone située assez loin de l’antenne, les champs E
�

 et B
�

 ont des 
propriétés simples : 

Le vecteur E
�

 a le même module en tout point d’un plan perpendiculaire à la propagation, 

E
�

 et B sont liés par : 

Le vecteur E
�

est perpendiculaire àB
�

, l’onde est dite plane. 

Les deux vecteurs E
�

et B
�

 sont perpendiculaires à la direction de propagation. 

E
�

et B
�

 varient en phase, les plans où E
�

 et B sont maximum avancent à la vitesse c de la 
lumière. 
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            Figure I-7 : Représentation de la propagation 
 
I-7.Paramètres de base d’une antenne
 
I-7-1.Bande de fréquences d'utilisation
 

L'antenne est un dipôle électrique qui se comporte comme un circuit résonant.
La fréquence de résonance de l'antenne dépend d'abord de ses dimensions mais aussi des 
éléments qui lui sont ajoutés. 
Par rapport à la fréquence de rés
affaiblissement (généralement 3 décibels) qui détermine la fréquence minimum et la 
fréquence maximum d'utilisation ; la différence entre ces deux fréquences est la bande 
passante. Il est fréquent qu'une antenne soit utilisée en réception largement en dehors de sa 
bande passante, c'est le cas des antennes d'auto
souvent à plus de 200 MHz et que l'on utilise pourtant pour l'écoute de la bande de 
radiodiffusion "FM" vers 100 MHz.
 
I-7-2.Bande passante et facteur de qualité
 

La bande passante d’une antenne correspond à la bande de fréquence où le transfert 
d’énergie de l’alimentation vers l’antenne (ou de l’antenne vers le récepteur) est maximale. La 
bande passante peut être définie en fonction du coefficient de réflexion, à condition que le 
diagramme de rayonnement ne change pas sur cette bande. Il n’y a pas de critères précis pour 
la limite du coefficient de réflexion.
inférieure a -10 dB ou -15 dB sur la bande passante.
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ntation de la propagation de l’onde plane. 

ramètres de base d’une antenne  

fréquences d'utilisation  

L'antenne est un dipôle électrique qui se comporte comme un circuit résonant.
La fréquence de résonance de l'antenne dépend d'abord de ses dimensions mais aussi des 

 
Par rapport à la fréquence de résonance centrale de l'antenne on peut tolérer un certain 
affaiblissement (généralement 3 décibels) qui détermine la fréquence minimum et la 
fréquence maximum d'utilisation ; la différence entre ces deux fréquences est la bande 

ne antenne soit utilisée en réception largement en dehors de sa 
passante, c'est le cas des antennes d'auto-radio dont la fréquence de résonance se situe 

à plus de 200 MHz et que l'on utilise pourtant pour l'écoute de la bande de 
"FM" vers 100 MHz. 

Bande passante et facteur de qualité 

La bande passante d’une antenne correspond à la bande de fréquence où le transfert 
de l’alimentation vers l’antenne (ou de l’antenne vers le récepteur) est maximale. La 

peut être définie en fonction du coefficient de réflexion, à condition que le 
ne change pas sur cette bande. Il n’y a pas de critères précis pour 

la limite du coefficient de réflexion. Un critère typique d’avoir un coeffic
15 dB sur la bande passante. 
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L'antenne est un dipôle électrique qui se comporte comme un circuit résonant. 
La fréquence de résonance de l'antenne dépend d'abord de ses dimensions mais aussi des 

onance centrale de l'antenne on peut tolérer un certain 
affaiblissement (généralement 3 décibels) qui détermine la fréquence minimum et la 
fréquence maximum d'utilisation ; la différence entre ces deux fréquences est la bande 

ne antenne soit utilisée en réception largement en dehors de sa 
radio dont la fréquence de résonance se situe 

à plus de 200 MHz et que l'on utilise pourtant pour l'écoute de la bande de 

La bande passante d’une antenne correspond à la bande de fréquence où le transfert 
de l’alimentation vers l’antenne (ou de l’antenne vers le récepteur) est maximale. La 

peut être définie en fonction du coefficient de réflexion, à condition que le 
ne change pas sur cette bande. Il n’y a pas de critères précis pour 

Un critère typique d’avoir un coefficient de réflexion 
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                         Figure I-8: Bande passante et coefficient de réflexion
 
Nous avons vu que l’antenne pouvait être vue comme un circuit
passante B est liée au facteur de qualité Q du circuit RLC à 
facteur de qualité représente la

                                 
res

BW
Q

f
=

                                                 
Une antenne avec un fort facteur de qualité rayonne très efficacement à la fréquence de 
rayonnement sur une bande de fr
bande. Cependant, si la bande passante est trop étroite, tout signal émis ou reçu près des 
bornes de la bande de fréquence de fonctionnement sera atténué. Une antenne avec un faible 
facteur de qualité est large bande mais collecte le bruit présent sur la bande de 
fonctionnement, dégradant ainsi la qualité du signal reçu.
 
I-7-3.diagramme de rayonnement

 
Le diagramme de rayonnement 

mathématique ou une représentation graphique
en fonction des coordonnées spatiales, caractérisant la distribution de puissance rad
antenne suivant une direction. En effet, une antenne réelle ne rayonne pas de façon 
omnidirectionnelle (isotrope). Son diagramme de rayonnement 
privilégiées (maximum de rayonnement) et des directions où le champ rayonné est nul.
Le tracé de ce diagramme s'effectue dans un système de coordonnées cartésiennes de  
référence (x, y, z) et les composantes du champ rayonné sont généralement exprimées en 
coordonnées sphériques (r, ,θ φ
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Bande passante et coefficient de réflexion 

ous avons vu que l’antenne pouvait être vue comme un circuit résonant
facteur de qualité Q du circuit RLC à la fréquence de résonance f 

facteur de qualité représente la quantité de résistance présente lors de la résonance.

 ;     
1

2 .
ant

res ant

R

Q f Lπ
= .                             

                                        
Une antenne avec un fort facteur de qualité rayonne très efficacement à la fréquence de 
rayonnement sur une bande de fréquence très étroite, ce qui peut limiter les interférences hors 

Cependant, si la bande passante est trop étroite, tout signal émis ou reçu près des 
fréquence de fonctionnement sera atténué. Une antenne avec un faible 

e qualité est large bande mais collecte le bruit présent sur la bande de 
fonctionnement, dégradant ainsi la qualité du signal reçu. 

diagramme de rayonnement  

Le diagramme de rayonnement d'une antenne est défini comme "une fonction 
une représentation graphique" des propriétés de rayonnement de l'antenne 

en fonction des coordonnées spatiales, caractérisant la distribution de puissance rad
direction. En effet, une antenne réelle ne rayonne pas de façon 

). Son diagramme de rayonnement présente des directions 
privilégiées (maximum de rayonnement) et des directions où le champ rayonné est nul.
Le tracé de ce diagramme s'effectue dans un système de coordonnées cartésiennes de  
référence (x, y, z) et les composantes du champ rayonné sont généralement exprimées en 

φ ). 
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ésonant RLC. La bande 
la fréquence de résonance f Res. Le 

e la résonance. 

Une antenne avec un fort facteur de qualité rayonne très efficacement à la fréquence de 
équence très étroite, ce qui peut limiter les interférences hors 

Cependant, si la bande passante est trop étroite, tout signal émis ou reçu près des 
fréquence de fonctionnement sera atténué. Une antenne avec un faible 

e qualité est large bande mais collecte le bruit présent sur la bande de 

d'une antenne est défini comme "une fonction 
des propriétés de rayonnement de l'antenne 

en fonction des coordonnées spatiales, caractérisant la distribution de puissance radiée par une 
direction. En effet, une antenne réelle ne rayonne pas de façon 

présente des directions 
privilégiées (maximum de rayonnement) et des directions où le champ rayonné est nul. 
Le tracé de ce diagramme s'effectue dans un système de coordonnées cartésiennes de  
référence (x, y, z) et les composantes du champ rayonné sont généralement exprimées en 
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                Figure I-8 : diagramme
     

En général, le diagramme de rayonnement est 
lointain et, représenté comme une 
rayonnement incluent: la densité du flux de puissance, l'intensité de rayonnement,
champ, la phase, la directivité et la polarisation. Ces grandeurs sont généralement normalisées 
(par rapport à une valeur maximale).

 
Les propriétés de rayonnement 

deux ou trois dimensions, de l'énergie rayonnée comme fonction de la position d'un 
observateur le long d'un chemin ou une surface de rayon constant. 

Dans la pratique, ce diagramme peut être un diagramme de puissa
champ (électrique ou magnétique). Il consiste à un tracé en fonction de 

de  ϕ (à θ constante). Il existe deux représentations:
-En système coordonnées polaires
-En système de coordonnées cartésiennes
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diagramme de rayonnement en coordonnées sphériques
       

En général, le diagramme de rayonnement est déterminé dans la
lointain et, représenté comme une fonction des coordonnées directionnelles. Les propriétés de 

: la densité du flux de puissance, l'intensité de rayonnement,
la directivité et la polarisation. Ces grandeurs sont généralement normalisées 

(par rapport à une valeur maximale). 

Les propriétés de rayonnement concernent généralement la distribution spatiale  en 
deux ou trois dimensions, de l'énergie rayonnée comme fonction de la position d'un 
observateur le long d'un chemin ou une surface de rayon constant.  

Dans la pratique, ce diagramme peut être un diagramme de puissance ou un diagramme de 
champ (électrique ou magnétique). Il consiste à un tracé en fonction de θ

constante). Il existe deux représentations: 
En système coordonnées polaires. 
En système de coordonnées cartésiennes.  

: Généralités sur les antennes 2013 

 

 

coordonnées sphériques. 
   

dans la région du champ 
fonction des coordonnées directionnelles. Les propriétés de 

: la densité du flux de puissance, l'intensité de rayonnement, intensité du 
la directivité et la polarisation. Ces grandeurs sont généralement normalisées 

généralement la distribution spatiale  en 
deux ou trois dimensions, de l'énergie rayonnée comme fonction de la position d'un 

nce ou un diagramme de 
θ (à ϕ constante) ou 
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  FigureI-9:Diagramme
     
     
     

            
                      
                  Figure I-10: Diagramme de rayonnement en  coordonnées cartésiennes
 
On prend l’exemple de l’antenne YAGI
 

                    

               Figure I-11 : Diagramme
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iagramme de rayonnement en coordonnées polaires

       
       
                                                                 

iagramme de rayonnement en  coordonnées cartésiennes

rend l’exemple de l’antenne YAGI-UDA  qui est une antenne directionnelle

: Diagramme de rayonnement de l’antenne YAGI-UDA.

: Généralités sur les antennes 2013 

 

  
en coordonnées polaires.  

  
  
                                                           

 

iagramme de rayonnement en  coordonnées cartésiennes. 

qui est une antenne directionnelle : 

 

UDA. 
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Lobes de rayonnement : 

C'est une portion du diagramme de rayonnement entourée par des régions de rayonnement 
faibles. Plusieurs parties du diagramme de rayonnement sont référées comme étant des l
et qui peuvent être classés en lobes secondaires, se trouvant soit de coté ou soit en arrière.

                                

FigureI-12: Lobes de rayonnement et largeur de faisceau du diagramme d'antenne, en 
coordonnées polaires. 
 

 

         

π/2 0π

1
(θ, φ =     r Cte )

0.5
A

(a)

Figure I-13: différents paramètres d'un diagramme de rayonnement bidimensionnel  (dans un 
plan vertical). (a) en coordonnées cartésiennes; (b) en coordonnées polaires.
 
a) Lobe principal : 
  Un lobe principal est défini comme étant un lobe contenant la direction du 
rayonnement maximum. Le diagramme de la figure 11
maximum est situé dans la direction 
certaines antennes peut présenter plus d'un lobe principal. 
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C'est une portion du diagramme de rayonnement entourée par des régions de rayonnement 
faibles. Plusieurs parties du diagramme de rayonnement sont référées comme étant des l

s en lobes secondaires, se trouvant soit de coté ou soit en arrière.

 

Lobes de rayonnement et largeur de faisceau du diagramme d'antenne, en 

θππ/2

Lobes latéraux

Lobe principal

Lobe arrières

B

θ 3 (à -3dB)

(b)

: différents paramètres d'un diagramme de rayonnement bidimensionnel  (dans un 
plan vertical). (a) en coordonnées cartésiennes; (b) en coordonnées polaires.

Un lobe principal est défini comme étant un lobe contenant la direction du 
um. Le diagramme de la figure 11 présente un seul lobe principal dont le 

maximum est situé dans la direction 0=θ  (axe Oz). Le diagramme de rayonnement de 
certaines antennes peut présenter plus d'un lobe principal.  

: Généralités sur les antennes 2013 

 

C'est une portion du diagramme de rayonnement entourée par des régions de rayonnement 
faibles. Plusieurs parties du diagramme de rayonnement sont référées comme étant des lobes 

s en lobes secondaires, se trouvant soit de coté ou soit en arrière. 

Lobes de rayonnement et largeur de faisceau du diagramme d'antenne, en 

                                   
: différents paramètres d'un diagramme de rayonnement bidimensionnel  (dans un 

plan vertical). (a) en coordonnées cartésiennes; (b) en coordonnées polaires. 

Un lobe principal est défini comme étant un lobe contenant la direction du 
présente un seul lobe principal dont le 
). Le diagramme de rayonnement de 



Chapitre I : Généralités sur les antennes 2013 

 

 
18 

 

 
b) Lobes secondaires 
 Les autres lobes, autres que les lobes principaux, sont appelés lobes secondaires et se 
subdivisent en lobes latéraux et lobes arrières. Les lobes latéraux, imposés par la distribution 
des amplitudes et des phases sur les sources rayonnantes constituant l'antenne, sont adjacents 
aux lobes principaux et occupent le même hémisphère. L'amplitude de ces lobes décroît 
régulièrement à mesure que l'on s'éloigne de la direction du rayonnement maximal. 
Les lobes arrières, liés aux imperfections de réalisations, sont situés dans l'hémisphère 
opposé. Les lobes secondaires représentent généralement le rayonnement dans les directions 
indésirables et par conséquent leur niveau doit être minimisé. Une antenne ayant un niveau 
des lobes secondaires de - 20 dB par rapport au niveau du lobe principal peut être satisfaisante 
dans beaucoup d'applications.     
 
I-7-4.l'impédance d’entrée d’une antenne 
 
Notions d’impédance 
 
Induction :  L'électromagnétisme est un phénomène réversible. Les variations d'un courant 
électrique entrainent des variations correspondantes du champ magnétique qu'elles créent de 
même que, les variations d'un champ magnétique induisent des courants variables dans les 
conducteurs. 
Si l'on approche ou l'on éloigne un aimant d'un bobinage, on fera apparaître un courant dans 
celui-ci. La variation du champ magnétique proche induira un courant électrique dans les 
spires de la bobine. 
De même, si deux bobinages sont alignés axialement, l'excitation de l'un par un courant 
électrique produira un champ magnétique induisant dans le second un courant inverse. Le 
courant induit semble s'opposer aux variations du courant inducteur. L'intensité du courant 
induit est proportionnelle  à la vitesse de variation et à l'intensité du courant induit.                                                                                     

La self-induction : 

 Si un courant circulant dans un bobinage peut induire un courant dans un autre bobinage se 
trouvant à proximité, il en induit aussi dans ses propres spires. Ce phénomène est soumis aux 
mêmes lois que le couple de bobinages inducteur-induit. En conséquence, si l'intensité du 
courant circulant dans une bobine augmente, un courant de self-induction en sens opposé 
prend naissance ralentissant ainsi l'augmentation du courant inducteur, et inversement. 

 Le bobinage semble s'opposer aux variations d'intensité. Ce phénomène de résistance de self-
induction ou inductance (L en Henrys) est d'autant plus élevée que la fréquence (f en Hertz) 
de variation est importante. 
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La résistance totale qu'oppose une bobine au passage d'un courant alternatif s'appelle 

l'impédance (Z en ohms) et se calcule par la formule 2 2(2 . . )z R L fπ= + ou R est la 

résistance (en ohms) ohmique pure du fil conducteur. 
 
Impédance d'entrée 
  
 L'impédance d'entrée d'une antenne caractérise la charge apportée par cette antenne au 
circuit d'excitation. Le cas le plus simple est celui des antennes pour lesquelles on peut définir 
deux bornes d'entrée telles qu'en régime d'émission, il existe entre elles une tension  

lorsque circule un courant  ; L'antenne peut alors être représentée par un dipôle, au sens de 

la théorie des circuits, dont l'impédance d'entrée serait aaa X jRZ +=                                                           

 Représentent respectivement la résistance et la réactance de l'antenne aux bornes de 

l'entrée a-b.  

 
Figure 1 a): Schéma équivalent en mode 
de réception  

 
Figure 2 b): Schéma équivalent en mode 
d'émission 

  

En général, la partie résistive  correspond à la somme de la puissance active rayonnée et à 

la puissance dissipée dans l'antenne. Elle peut donc s'écrire sous la forme  

LRRR ra +=                                                                         

L  Ret Rr sont respectivement la résistance de rayonnement et la résistance de pertes de 

l'antenne.  
 

Ve

Ie

Ra et Xa

Ra
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La première est une caractéristique dépendant du champ lointain dont on sait qu'il peut être 
obtenu à partir de la répartitions approchées du courant sur l'antenne, alors que la seconde se 
déduit de la connaissance du champ dans l'antenne et permet de représenter les pertes 
électriques et diélectriques. Ceci permet de définir le rendement de l'antenne sous la forme 
d'un rapport de résistances 

                                                 
Lr

r

RR

R
cd

+
=η      (eq10)                                                                 

 
Pour une barre métallique de longueur l,  de section droite A et de conductivitéσ , la  

résistance en régime continu est  )(      
A

l
 Rdc Ω

σ
1

=  (eq11)                                                      

Si la profondeur de pénétration (épaisseur de peau) dans le métal ( ) est très 

faible devant la plus faible des dimensions de la section droite de la barre, le courant circule 
sur une fine couche située au voisinage de la surface du conducteur. 

 La résistance aux hautes fréquences de cette barre s'écrit )(              
P

l
R

P

l
R o

shf Ω
σ
ωµ

2
==                                               

P est le périmètre de la section droite de la barre ( R P π2= pour un cylindrique de rayon R), 

sR  est la résistance de la surface du conducteur, ω  est la pulsation et oµ  la perméabilité en 

espace libre. 

En plus de la diminution du rendementcdη , la résistance de pertes LR  introduit un autre effet 

indésirable. En effet, comme dans tout système électrique, une résistance ohmique est une 
source de bruit au niveau de l'antenne. Ainsi, une valeur élevée de cette résistance au niveau 
d'une antenne de réception introduit du bruit au niveau du récepteur. 
Pour la partie imaginaire  de l'impédance d'entrée représentant l'énergie réactive contenue 

dans le champ proche, conformément à la théorie des circuits électriques, le problème est 
moins simple. Toute décomposition de  serait purement arbitraire puisqu'elle reposerait sur 

le choix d'une surface fermée S à travers laquelle on évalue le flux du vecteur de Poynting. 
 Les antennes de dimensions très inférieures à la longueur d'onde, présentent, en plus 
de leur faible résistance de rayonnement, une réactance de valeur élevée. Ainsi, un doublet 
électrique présente une réactance capacitive alors qu'un doublet magnétique présente une 
réactance inductive. Ces résultats sont conformes à la théorie des circuits basse fréquence. 
 

Le transfert maximum de puissance de l'émetteur vers l'antenne d'émission (de 
l'antenne de réception vers le récepteur) exige l'adaptation d'impédance entre les deux 
dispositifs. Généralement, un récepteur présente une impédance d'entrée purement réelle, des 
circuits d'adaptation permettant de compenser la réactance de l'antenne de réception sont donc 
nécessaires. L'introduction de ce type de circuits engendre deux problèmes: ils sont source de 
bruit à cause de leur résistance ohmique et ne permettent l'adaptation que sur une bande de 
fréquence généralement étroite.  
 
 

δ δ µ σ ω= 2 / ( )o  

Xa

Xa
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I-7-5. Adaptation et condition d’adaptation
 
 Une antenne est reliée à la source par une ligne de transmission d’impédance 
caractéristique Zc (en général, Zc
entre l’alimentation et l’antenne, il est nécessaire d’assurer une adaptation d’impédance. 
L’adaptation permet d’annuler le coefficient de réflexion 

 

                    
Si l’adaptation n’est pas assurée, une partie de la puissance 
Source. En pratique, soit on cherchera à
présente une impédance égale à Zc à la fréquence de
l’antenne un circuit de transformation d’impédance qui
l’antenne vue depuis la source et assurera l’adaptation
Remarque  
Bien que les pertes par désadaptation réduisent l’efficacité d’une antenne, celles
les pertes par polarisation) ne sont généralement pas incluses dans le calcul de l’efficacité 
Dans les notes d’application d’antennes, l’adaptation de l’antenne est souvent caractérisée par
le rapport d’onde stationnaire (ROS) ou Voltage Standing Wave Ratio (VSWR). 
 
 Lorsqu’il y a désadaptation, la réflexion d’une partie de l’onde incidente et 
avec l’onde réfléchie conduit
l’antenne à la source (ou au récepteur).
L’amplitude de cette onde stationnaire n’est pas 
maximale en certains endroits (ventres) et minimale à d’autres (
Le rapport d’onde stationnaire
minimale de cette onde. Le TOS 
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Adaptation et condition d’adaptation 

Une antenne est reliée à la source par une ligne de transmission d’impédance 
général, Zc = 50Ω). Pour assurer un transfert maximal de puissance 

entre l’alimentation et l’antenne, il est nécessaire d’assurer une adaptation d’impédance. 
L’adaptation permet d’annuler le coefficient de réflexion Γin ou S11 en entr

        2( |   | )    A S inP P= − Γ et 11 in

Z Z
s

Z Z
= Γ =

rée, une partie de la puissance est renvoyée vers la
. En pratique, soit on cherchera à concevoir l’antenne de telle manière à ce qu’elle 

présente une impédance égale à Zc à la fréquence de travail, soit on disposera en entrée de 
l’antenne un circuit de transformation d’impédance qui modifiera l’impédance d’entrée de 

ource et assurera l’adaptation d’impédance.  

Bien que les pertes par désadaptation réduisent l’efficacité d’une antenne, celles
les pertes par polarisation) ne sont généralement pas incluses dans le calcul de l’efficacité 

s notes d’application d’antennes, l’adaptation de l’antenne est souvent caractérisée par
rapport d’onde stationnaire (ROS) ou Voltage Standing Wave Ratio (VSWR). 

désadaptation, la réflexion d’une partie de l’onde incidente et 
conduit à l’apparition d’une onde stationnaire dans la ligne qui relie 

l’antenne à la source (ou au récepteur). 
L’amplitude de cette onde stationnaire n’est pas constante le long de la ligne (

oits (ventres) et minimale à d’autres (nœuds)).  
Le rapport d’onde stationnaire est le rapport entre l’amplitude maximale et l’amplitude 

de cette onde. Le TOS est lié au coefficient de réflexion.  
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Une antenne est reliée à la source par une ligne de transmission d’impédance 
). Pour assurer un transfert maximal de puissance 

entre l’alimentation et l’antenne, il est nécessaire d’assurer une adaptation d’impédance. 
in ou S11 en entrée de l’antenne.  

in c

in c

Z Z

Z Z

−
+

 

 
est renvoyée vers la 

concevoir l’antenne de telle manière à ce qu’elle 
travail, soit on disposera en entrée de 

modifiera l’impédance d’entrée de 

Bien que les pertes par désadaptation réduisent l’efficacité d’une antenne, celles-ci (ainsi que 
les pertes par polarisation) ne sont généralement pas incluses dans le calcul de l’efficacité η. 

s notes d’application d’antennes, l’adaptation de l’antenne est souvent caractérisée par 
rapport d’onde stationnaire (ROS) ou Voltage Standing Wave Ratio (VSWR).  

désadaptation, la réflexion d’une partie de l’onde incidente et l’addition 
à l’apparition d’une onde stationnaire dans la ligne qui relie 

constante le long de la ligne (l’amplitude est 

est le rapport entre l’amplitude maximale et l’amplitude 
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I-7-6.Analyseur de réseau  
 

L’impédance d’une antenne peut être mesurée à l’aide d’un analyseur de réseau. 
Connecté à l’entrée d’une antenne, celui
séparer l’onde incidente de l’onde réfléchie, et ainsi de mesurer le coefficient de réflexion et 
donc d’en déduire l’impédance à la fréquence considérée. Néanmoins, l’utilisation de cet 
appareil nécessite une étape de
référence de l’antenne. 
 

 
                                              Figure I
 
I-7-7.la polarisation  
 

La polarisation d'une antenne dans une direction donnée est définie comme étant la 
polarisation de l'onde transmise (rayonnée)  par l'antenne. Dans la pratique, la polarisation des 
ondes transmises varie avec leurs 
La polarisation d'une antenne est la propriété décrivant la variation temporelle de la direction 

et du module du champ électrique 

courbe décrite dans le temps par l'ex
de propagation. 
 

La polarisation peut être linéaire, circulaire ou elliptique. Si le vecteur 
direction constante dans le temps, la polarisation est linéaire ou rectiligne; en général, c'est 

une polarisation qui est soit horizontale, soit ve

antennes filaires. Dans le cas général, le champ électrique 
polarisation est alors dite elliptique. 
Les polarisations linéaires et circulaire
sont obtenues respectivement lorsque l'ellipse devient une droite ou un cercle.
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d’une antenne peut être mesurée à l’aide d’un analyseur de réseau. 
l’entrée d’une antenne, celui-ci transmet un signal harmonique et est capable de 

incidente de l’onde réfléchie, et ainsi de mesurer le coefficient de réflexion et 
l’impédance à la fréquence considérée. Néanmoins, l’utilisation de cet 

appareil nécessite une étape de calibration précise pour mesurer l’impédance dans le plan de 

Figure I-14 : Analyseur de réseau.  

La polarisation d'une antenne dans une direction donnée est définie comme étant la 
polarisation de l'onde transmise (rayonnée)  par l'antenne. Dans la pratique, la polarisation des 

es transmises varie avec leurs directions.  
La polarisation d'une antenne est la propriété décrivant la variation temporelle de la direction 

et du module du champ électrique E
�

 rayonné par cette antenne. Elle est caractérisée par la 

courbe décrite dans le temps par l'extrémité du vecteur E
�

 et observée à partir de la direction 

La polarisation peut être linéaire, circulaire ou elliptique. Si le vecteur 
direction constante dans le temps, la polarisation est linéaire ou rectiligne; en général, c'est 

une polarisation qui est soit horizontale, soit verticale selonE
�

. C'est le cas de la majorité des 

antennes filaires. Dans le cas général, le champ électrique E
�

 décrit une ellipse et la 
polarisation est alors dite elliptique.  

et circulaires sont des cas particuliers de la polarisation elliptique et 
sont obtenues respectivement lorsque l'ellipse devient une droite ou un cercle.
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d’une antenne peut être mesurée à l’aide d’un analyseur de réseau. 
ci transmet un signal harmonique et est capable de 

incidente de l’onde réfléchie, et ainsi de mesurer le coefficient de réflexion et 
l’impédance à la fréquence considérée. Néanmoins, l’utilisation de cet 

calibration précise pour mesurer l’impédance dans le plan de 

 

La polarisation d'une antenne dans une direction donnée est définie comme étant la 
polarisation de l'onde transmise (rayonnée)  par l'antenne. Dans la pratique, la polarisation des 

La polarisation d'une antenne est la propriété décrivant la variation temporelle de la direction 

rayonné par cette antenne. Elle est caractérisée par la 

et observée à partir de la direction 

La polarisation peut être linéaire, circulaire ou elliptique. Si le vecteur E
�

 garde une 
direction constante dans le temps, la polarisation est linéaire ou rectiligne; en général, c'est 

. C'est le cas de la majorité des 

décrit une ellipse et la 

sont des cas particuliers de la polarisation elliptique et 
sont obtenues respectivement lorsque l'ellipse devient une droite ou un cercle. 
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                                   Figure I-15: Polarisation des ondes EM. 
 
I-7-8.Le vecteur longueur effective (Longueur vectorielle effective)  
 

Une antenne en mode de réception a pour rôle de capter des ondes EM et d'y extraire 
les puissances transportées. On définie alors pour chaque antenne une longueur équivalente et 
un nombre de surfaces équivalents. Ces quantités équivalentes sont utilisées pour décrire les 
caractéristiques de réception d'une antenne lorsqu’elle reçoit une onde incidente.  
Le vecteur longueur effective d'une antenne (aussi désigné comme la hauteur effective), 
qu'elle soit filaire ou une antenne à fente, est une quantité qui est utilisée pour déterminer la 
tension induite sur les bornes en circuit ouvert de l'antenne lorsqu’il sera empiété par une 
onde. Le vecteur longueur effective est en général une quantité complexe représentée par:  

( ) ( )φθφθ φθθ ,lâ,lâl φe +=    (eq. 12) 

Il est aussi désigné comme la hauteur effective. C’est une quantité de champ lointain qui est 
relié au champ lointain Ea rayonnée par l'antenne parcourue par un courant I in: 

jkr
e

in_
a

_
el

r

kI
jEˆEˆE

4π
ηφθθ =+= φaa  (eq. 13) 

Cette longueur effective représente l'antenne en mode de réception et d'émission et elle est  
particulièrement utilisée pour relier la tension en circuit ouvert d'une antenne réceptrice aux 
champs incidents. Cette relation peut être exprimée par: 

e
i

oc .V lE=   (Eq. 14) 

où  ocV la tension en circuit ouvert au bornes d'une antenne et iE  le champ électrique 

incident. 
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I-7-9.Facteur de pertes de polarisation  
 
 En général, la polarisation d'une antenne de réception est différente de celle de l'onde 
incidente qui lui parvient. Ceci est désigné souvent comme étant "une désadaptation de 
polarisation". La puissance reçue par cette l’antenne n'est donc pas maximale à cause des 

pertes par polarisation. En effet, supposons un champ incident de la forme  iii ê EE =
�

                                                   

Où iê est un vecteur unitaire indiquant la polarisation du champ reçu et soit une antenne de 

réception polarisée comme suit : 

                                          r
r
er

r
err ê h  E=h  EE
��

=  (eq15)                                           

Où r
r
e ê  et h
�

 indiquent respectivement le vecteur hauteur effective et la polarisation de 

l'antenne de réception. 
Les pertes (en puissance) par polarisation peuvent être caractérisées par le facteur PLF 

(polarization loss facteur) défini par 
2

p
*
ri cosê.êPLF

2

ψ== (eq16)                                            

Où ψ p représente l'angle entre les deux vecteurs unitaires ɵei  et ɵer  (Fig.16). Si ces deux 

vecteurs ont la même direction, (même polarisation à l'émission et à la réception), le PLF est 
égale à l'unité (ou 0 dB) et la puissance reçue par l'antenne de réception à partir du champ 
incident est maximale. 

                                              

ei
^

ψp

er
^ *

  

                                  Figure 16: Vecteurs unitaires de polarisation 

 Un autre paramètre qui est aussi utilisé pour décrire les caractéristiques de la 
polarisation d'une onde et celle d'une antenne, est le rendement de la polarisation (appelé aussi 
adaptation de polarisation ou facteur de pertes) et qui est défini comme le rapport de 
puissance reçue par une antenne d'une onde plane arbitrairement polarisée à la puissance que 
doit être reçue par la même antenne d'une onde plane de même flux de densité de puissance et 
de même direction de propagation. Ce qui exprime que la polarisation a été ajustée pour une 
puissance reçue maximale. Elle est donné par: 

               
22

2
.

inc
e

inc
e

e
El

El
p =    (eq. 17) 
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Où  

le est le vecteur longueur effective de l'antenne. 

Einc le champ électrique incident.  

 
I-7-10.Gain d'une antenne 
 

Un autre paramètre aussi très utilisable qui sert à décrire les performances d'une 
antenne est le gain. Malgré que le gain soit relié étroitement à la directivité, c'est une mesure 
qui tient compte du rendement de l'antenne (donc des pertes) aussi bien que sa capacité 
directionnelle.  
Le gain en puissance d'une antenne dans une direction donnée est défini comme étant le 
rapport de l'intensité de rayonnement dans une direction ∆ ( , )θ φ  sur l'intensité de rayonnement 

qui peut être obtenue si la puissance acceptée par l'antenne sera rayonnée de façon isotrope. 
Cette dernière est tout simplement la puissance fournie  à l'antenne par la ligne de 
transmission issue de l'émetteur divisée par 4π (tout l'espace). 
Il est donc formulé comme suit : 

fP

),(U
4

totalefourniePuissance

rayonementdeIntensité
4),(G

φθππφθ ==   eq(18)                            

Mais, dans la majorité des cas, on à  affaire à un gain relatif qui est défini comme étant le 
rapport du gain en puissance dans une direction donnée Gp ( , )θ φ  au gain en puissance d'une 

antenne référence dans sa direction référencée, recevant la même puissance fourniePf . 

L'antenne référence est généralement un dipôle ou n'importe quelle antenne ou son gain peut 
être calculé ou bien  est connu (le plus souvent une source isotrope sans pertes). 

( )
( ) ( )ensionssans

pertessansisotropesourceP

U
G

f

dim
,

4
ϕθπ=  (eq19) 

Pour une source isotrope sans pertes rayf PP = et son intensité est 
π4

P
U ray

0 =  

Pour une antenne réelle quelconque drayf PPP +=   ( dP  étant les différentes pertes en 

puissance dans l'antenne: par effet Joule, dans le diélectrique, désadaptation). Pour une telle 

antenne, on définit la notion de rendement : 
f

ray
cd P

P
=η    (eq 20) 

Dans ces conditions le gain relatif de l'antenne s'écrit alors: 

ray
cd P

),(U 4
 ),(G

φθπηφθ =   (eq 21) 

 

Et il est relié à la directivité par : ),(D),(G cd φθηφθ  =   (eq 22). 
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I-7-11.Température d'une antenne  
 
On sait que n'importe quel objet avec une température au dessus du 0°K rayonne de l'énergie. 
Cette quantité d'énergie est généralement exprimée par une température équivalente BT  

connue comme la "température de luminosité" (brightness temperature). Elle est définie par : 

( ) m

2_
mB T1T),(),(T Γφθεφθ ==  (eq23) 

-εεεε  est l'émissivité ( 10 ≤≤≤≤≤≤≤≤εεεε ) 

- mT  la température moléculaire en K. 

- ΓΓΓΓ  coefficient de réflexion de la surface pour la polarisation de l'onde. 
 
La température de luminosité émise par différentes sources est interceptée par les antennes et 
apparaît à leurs bornes comme une température d'antennes. Elle est    
Donné par : 

                    
φθθφθ

φθθφθφθ
π π

π π

ddsin),(G

ddsin),(G),(T
T

∫∫

∫∫
2

0 0

2

0 0 B

A =     (eq.24) 

AT  est la température de l'antenne (température de bruit effective de la résistance de 

rayonnement de l'antenne en °K) et ),(G φφφφθθθθ  le gain de l'antenne. 

En supposant qu'il n'y a pas de pertes ni contribution entre l'antenne et le récepteur, la 
puissance du bruit transmis au récepteur est donné par: fkTP Ar ∆=         (eq.25) 

rP  La puissance du bruit de l'antenne. 

k  constante de Boltzmann. 

AT  Température de l'antenne. 

f∆  La bande passante. 
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I-7-13.L es Régions du champ
 

L'espace qui entoure l'antenne est généralement divisée en trois régions:
 Le champ proche réactif: Dénommée également zone de Rayleigh, définie comme étant la 
région entourant immédiatement l'antenne où un champ réactif est prédominant. Pour la 

majorité des antennes, cette région s'étend de la surface de l'antenne 

Où D est la dimension de l'antenne la plus 
proche appelée  aussi  zone  
entre la région proche réactive
Prédominant.  
La région du champ lointain: appelée zone de Fraunhofer, est définie comme étant la région
Où une antenne dont la distribution angulaire du champ est essentiellement indépendante de la
Distance de l'antenne. En général, elle est prise à partir de la distance supérieure à 2D
(si D est grand par rapport à p/
Dans cette région, les composantes du champ sont essentiellement transvers
rapport à la direction radial) et la distribution angulaire est pratiquement indépendante de 
distance radiale. 
 

                  
                         Figure I-17 : montrant les trois régions du champ
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Régions du champ 

L'espace qui entoure l'antenne est généralement divisée en trois régions:
Le champ proche réactif: Dénommée également zone de Rayleigh, définie comme étant la 
région entourant immédiatement l'antenne où un champ réactif est prédominant. Pour la 

majorité des antennes, cette région s'étend de la surface de l'antenne jusqu’à

D est la dimension de l'antenne la plus importante. La région de rayonnement du champ 
 de  Fresnel est définie comme étant la région intermédiaire 

réactive et la région du champ lointain où le champ actif

appelée zone de Fraunhofer, est définie comme étant la région
une antenne dont la distribution angulaire du champ est essentiellement indépendante de la

de l'antenne. En général, elle est prise à partir de la distance supérieure à 2D
si D est grand par rapport à p/|γ|, R>|γ|D²/π où γ est la constante de propagation du milieu). 

Dans cette région, les composantes du champ sont essentiellement transvers
rapport à la direction radial) et la distribution angulaire est pratiquement indépendante de 

montrant les trois régions du champ. 

: Généralités sur les antennes 2013 

 

L'espace qui entoure l'antenne est généralement divisée en trois régions: 
Le champ proche réactif: Dénommée également zone de Rayleigh, définie comme étant la 
région entourant immédiatement l'antenne où un champ réactif est prédominant. Pour la 

jusqu’à
3

0.62 DR λ≺ .   

de rayonnement du champ 
Fresnel est définie comme étant la région intermédiaire   

actif rayonné est  

appelée zone de Fraunhofer, est définie comme étant la région 
une antenne dont la distribution angulaire du champ est essentiellement indépendante de la 

de l'antenne. En général, elle est prise à partir de la distance supérieure à 2D2/ λ 
 est la constante de propagation du milieu). 

Dans cette région, les composantes du champ sont essentiellement transverses (TEM par 
rapport à la direction radial) et la distribution angulaire est pratiquement indépendante de 
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I-7-14.Vecteur de Poynting  

Les ondes EM sont utilisées pour transporter des informations à travers un milieu (sans fils ou 
dans des structures guidant) d'un point à un autre. La quantité utilisée pour décrire la 

puissance associée, est vecteur de Poynting instantané, défini comme : HΕW
���

×=                                                        

W: le  vecteur de Poynting (watt/m2). 

E: l'intensité du champ électrique instantanée et est égale à ( )( )tjez,y,xEReE ω= . 

H : l'intensité du champ magnétique instantanée et est égale ( )( )tjez,y,xHReH ω= . 

La densité de puissance rayonnée : 

Comme le vecteur de Poynting représente une densité surfacique de puissance, la 
puissance totale à travers une surface fermée sera donc obtenue en intégrant la composante 
normale du vecteur de Poynting sur la surface entière. La puissance instantanée est donc 

donnée par dsn̂.Wsd.WP
SS

���

∫∫∫∫ ==  (eq 26) .                                                              

Dans beaucoup d'applications, où la variation temporelle du champ électromagnétique est 
périodique, il est très pratique de trouver la densité de puissance moyenne qui est obtenue en 
intégrant le vecteur de Poynting instantané sur une période.    

Le vecteur de Poynting peut s'écrire alors sous la forme: 

( ) ( )tj2* eHERe
2

1
HERe

2

1
HEW ω�������

×+×=×=     (eq 27)                                                                                         

Et la valeur moyenne est donnée par : 

                                         ( ) ( )*
moy HERe

2

1
z,y,xW

��
×=  (eq 28)                                                                                                         

La représentation graphique de la densité de puissance moyenne, comme fonction de la 
direction, est justement le diagramme de puissance de l'antenne (en termes de diagramme gain 
ou de puissance relative). 

Remarque: 

Si la partie réelle de cette expression représente la valeur moyenne de la densité de puissance 
active (prédominante dans la zone du champ lointain) donc rayonnée par l'antenne (sans 
pertes), il est naturel d'admettre que sa partie imaginaire doit représenter la densité de 
puissance réactive  (emmagasinée dans la zone proche, c'est à dire au voisinage de l'antenne) 
associée à l'onde EM. 

La puissance moyenne rayonnée par une antenne peut s'écrire sous la forme 

[ ]∫∫∫∫∫∫ ds n̂ .Re
2

1
ds n̂ .ds n̂ . *

SS moyS raymoyray HEWWPP
��

×==== .         
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I-8. Types d’antennes  

Une antenne est dite idéale si elle rayonne toute la puissance qu’elle lui a été 
délivrée à partir de la ligne de transmission, dans une ou plusieurs directions désirées. 
Dans la pratique, ces performances idéales ne peuvent être réalisés mais peuvent être 
minutieusement approchées.une grande variété d’antennes existe et chaque type peut 
prendre une forme afin d’accomplir une caractéristique de rayonnement désirée pour une 
application donnée. 
On va voir les grandes familles d’antennes à l’origine de l’ensemble des structures 
rayonnantes : 
 Les antennes filaires (dipôle, monopôle, Yagi)
 Les antennes à fentes (demi ou quart d’onde)
 Les antennes patchs (planaires)
 Les antennes à ouverture (cornet)
 Les antennes à réflecteurs (paraboles)
 
I-8-1.Antennes filaires  
 
C’est les plus familiers des antennes puisque vue partout
voitures… etc il existe une grande variété de forme
circulaire rectangulaire ellipse, hélice…

               Figure I-18 : antenne dipôle, circulaire, hélice
 
Le dipôle est l’antenne de référence en 
tel quel où en  l’association avec d’autres conducteurs pour
Le dipôle a une longueur totale d’une demi
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Une antenne est dite idéale si elle rayonne toute la puissance qu’elle lui a été 
partir de la ligne de transmission, dans une ou plusieurs directions désirées. 

Dans la pratique, ces performances idéales ne peuvent être réalisés mais peuvent être 
minutieusement approchées.une grande variété d’antennes existe et chaque type peut 

une forme afin d’accomplir une caractéristique de rayonnement désirée pour une 

On va voir les grandes familles d’antennes à l’origine de l’ensemble des structures 

antennes filaires (dipôle, monopôle, Yagi). 
antennes à fentes (demi ou quart d’onde). 
antennes patchs (planaires). 
antennes à ouverture (cornet). 
antennes à réflecteurs (paraboles). 

C’est les plus familiers des antennes puisque vue partout : sur les toits, 
une grande variété de forme : rectiligne (dipôle), boucle

circulaire rectangulaire ellipse, hélice…etc. 

: antenne dipôle, circulaire, hélice 

Le dipôle est l’antenne de référence en radiocommunication et elle est largement 
association avec d’autres conducteurs pour former une antenne Yagi.

ale d’une demi-longueur d’onde . 
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Une antenne est dite idéale si elle rayonne toute la puissance qu’elle lui a été 
partir de la ligne de transmission, dans une ou plusieurs directions désirées. 

Dans la pratique, ces performances idéales ne peuvent être réalisés mais peuvent être 
minutieusement approchées.une grande variété d’antennes existe et chaque type peut 

une forme afin d’accomplir une caractéristique de rayonnement désirée pour une 

On va voir les grandes familles d’antennes à l’origine de l’ensemble des structures 

: sur les toits, les avions, les 
: rectiligne (dipôle), boucle : 

 

largement utilisée 
former une antenne Yagi. 
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                        Figure I-19 : Dipôles verticaux d’un émetteur FM
 
I-8-2.Antennes fentes : 
 
Ce type d’antenne est très utilisé dans les avions ou les vaisseaux spatiaux car, 
être facilement montés sur leurs 

                             
                                    Figure I
 
I-8-3.Antennes microrubans 
 
Elles sont devenues très populaire depuis les années 70.
spatiales puis, dans des applications commerciales.
Ces antennes sont constituées par un patch métallique monté sur un substrat avec un plan 
de masse. Le patch peut prendre n’importe qu’elle forme mais les plus populaires sont les 
formes rectangulaires et circulaires.
 

Chapitre I : Généralités sur les antennes

30 

 
Dipôles verticaux d’un émetteur FM 

Ce type d’antenne est très utilisé dans les avions ou les vaisseaux spatiaux car, 
être facilement montés sur leurs surfaces. 

 
Figure I-20 : Les antennes à fentes. 

ntennes microrubans  

Elles sont devenues très populaire depuis les années 70.Au début, pour d
applications commerciales. 

Ces antennes sont constituées par un patch métallique monté sur un substrat avec un plan 
de masse. Le patch peut prendre n’importe qu’elle forme mais les plus populaires sont les 
formes rectangulaires et circulaires. 

: Généralités sur les antennes 2013 

 

 

Ce type d’antenne est très utilisé dans les avions ou les vaisseaux spatiaux car, ils peuvent 

Au début, pour des applications 

Ces antennes sont constituées par un patch métallique monté sur un substrat avec un plan 
de masse. Le patch peut prendre n’importe qu’elle forme mais les plus populaires sont les 
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          Figure I-20 : Antennes patch 
 
I-8-4.Antennes réseaux  

Beaucoup d’applications requis  des rayonnements qui ne peuvent pas achevées 
par des éléments simples. Alors, il est possible de former un ensemble d’éléments 
rayonnants dans un arrangement électrique et géométrique pour avoir la caractéristique de 
rayonnement désirée. 
L’arrangement de ce réseau est tel que le rayonnement des éléments donne 
rayonnement maximum dans une direction particu
autrement suivant les exigences 
figure suivante. 
En général, le terme réseau est réservé a un arrangement ou dans lequel les éléments 
rayonnants sont séparés.Toute fois, le même terme et aussi 
assemble d’éléments rayonnant

 
 
                                     Figure I
 
 
 
 

Chapitre I : Généralités sur les antennes

31 

ntennes patch  à élément rayonnant triangulaire et circulaire.

d’applications requis  des rayonnements qui ne peuvent pas achevées 
par des éléments simples. Alors, il est possible de former un ensemble d’éléments 
rayonnants dans un arrangement électrique et géométrique pour avoir la caractéristique de 

ce réseau est tel que le rayonnement des éléments donne 
maximum dans une direction particulière, minimum dans une autre où

autrement suivant les exigences des exemples typiques de réseaux sont représentés par la 

En général, le terme réseau est réservé a un arrangement ou dans lequel les éléments 
oute fois, le même terme et aussi utilisé pour décrire un 

d’éléments rayonnants sur une structure continue. 

Figure I-21 : Exemples d’antennes réseaux.  

: Généralités sur les antennes 2013 

 

 
rculaire. 

d’applications requis  des rayonnements qui ne peuvent pas achevées 
par des éléments simples. Alors, il est possible de former un ensemble d’éléments 
rayonnants dans un arrangement électrique et géométrique pour avoir la caractéristique de 

ce réseau est tel que le rayonnement des éléments donne un 
lière, minimum dans une autre où 

des exemples typiques de réseaux sont représentés par la 

En général, le terme réseau est réservé a un arrangement ou dans lequel les éléments 
utilisé pour décrire un 
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I-8-5.Antennes réflecteurs  
 

Le besoin de communiquer à des grandes distances a permis d’élaborer des 
formes d’antennes capables de transmettre et de recevoir des signaux qui devraient
traverser des millions de kilomètres.
Une forme courante pour de telles applications est le réflecteur parabolique avec des 
diamètres de plus de 305 m. 

                          
 
                                Figure I-2
 
I-9.Conclusion 
Dans ce chapitre nous avons traité les notions d
équations de Maxwell pour la compréhension des  phénomènes de propagation 
électromagnétique,les caractéristiques de base de toutes les ante
d’entée, le diagramme de rayonnement, le gain, la polarisation…etc ,
acquises  pour se lancé dans n’importe quel étude sur les antennes d’où leur importances, 
ces notions sont considérées comme fon
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Le besoin de communiquer à des grandes distances a permis d’élaborer des 
formes d’antennes capables de transmettre et de recevoir des signaux qui devraient
traverser des millions de kilomètres. 
Une forme courante pour de telles applications est le réflecteur parabolique avec des 

2 : Schéma illustrant l’antenne parabolique. 

us avons traité les notions d’électromagnétisme  et l’importance des 
équations de Maxwell pour la compréhension des  phénomènes de propagation 

les caractéristiques de base de toutes les antennes tel que l’impédance 
d’entée, le diagramme de rayonnement, le gain, la polarisation…etc , qui devraient être 

e lancé dans n’importe quel étude sur les antennes d’où leur importances, 
ces notions sont considérées comme fondamentales. 

: Généralités sur les antennes 2013 

 

Le besoin de communiquer à des grandes distances a permis d’élaborer des 
formes d’antennes capables de transmettre et de recevoir des signaux qui devraient 

Une forme courante pour de telles applications est le réflecteur parabolique avec des 

 

et l’importance des 
équations de Maxwell pour la compréhension des  phénomènes de propagation 

tel que l’impédance 
qui devraient être 

e lancé dans n’importe quel étude sur les antennes d’où leur importances, 
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II-1.Introduction  
 

Nous allons faire une brève présentation de l’antenne patch vu que c’est une antenne 
très populaire de nos jours et très utilisé. Par rapport a sa taille réduite et son pouvoir 
d’adaptation aux surfaces planes et non plane .elle
résonance, de polarisation, d’impédance d’entrée et de diagramme de rayonnement que nous 
allons traiter dans ce chapitre. 
 
II-2.Définition  

L’antenne planaire ou patch (en anglais) est une antenne plane dont l'élément 
rayonnant est une surface conductrice généralement carrée, séparée d'un plan réflecteur 
conducteur par une lame diélectrique. Sa 
face, substrat, elle est donc favorable à une production industrielle. Elle peut être utilisée seule 
ou comme élément d'un réseau.
l'encombrement d'une antenne,
exemple sur les émetteurs-récepteurs
GPS, ... Les antennes planaires en réseau
dans de nombreuses transmissions
des technologies permettant la réalisation
navigation aérienne, surveillance ou observation de la
Le concept d’antennes patch est apparu dans les années 50, mais le véritable développement
ne s’est fait que dans les années 70
Ceux-ci peuvent être intégrés au plus près des circuits électroniques en occup
réduit et se conformant à différents types de surface
faible coût de fabrication. Les antennes patch
à partir des bandes VHF (Fig.1)
 
 
        

                                           Figure 
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ous allons faire une brève présentation de l’antenne patch vu que c’est une antenne 
et très utilisé. Par rapport a sa taille réduite et son pouvoir 

d’adaptation aux surfaces planes et non plane .elle est également très performante
résonance, de polarisation, d’impédance d’entrée et de diagramme de rayonnement que nous 

dans ce chapitre.  

L’antenne planaire ou patch (en anglais) est une antenne plane dont l'élément 
surface conductrice généralement carrée, séparée d'un plan réflecteur 

diélectrique. Sa réalisation ressemble à un circuit im
favorable à une production industrielle. Elle peut être utilisée seule 

ou comme élément d'un réseau. Les antennes planaires sont utilisées lorsqu'on veut réduire 
d'une antenne, notamment sa hauteur au-dessus d'un plan de masse, par 

récepteurs portables de radiocommunications, sur les récepteurs 
GPS, ... Les antennes planaires en réseau sont employées en Wi-Fi, en radioamateurisme et 

de nombreuses transmissions professionnelles. L'antenne patch en réseau actif est une 
des technologies permettant la réalisation des antennes radar à faisceau contrôlé, en 
navigation aérienne, surveillance ou observation de la Terre par satellite. 

pt d’antennes patch est apparu dans les années 50, mais le véritable développement
st fait que dans les années 70. L’antenne est réalisée par gravure d’un circuit imprimé. 
ci peuvent être intégrés au plus près des circuits électroniques en occup

réduit et se conformant à différents types de surfaceS. Leur principal avantage réside dans leur 
faible coût de fabrication. Les antennes patchs sont utilisées dans de nombreuses applications 

partir des bandes VHF (Fig.1) 

Figure II-1 : Exemple d’antennes patchs. 
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ous allons faire une brève présentation de l’antenne patch vu que c’est une antenne 
et très utilisé. Par rapport a sa taille réduite et son pouvoir 

est également très performante en terme de 
résonance, de polarisation, d’impédance d’entrée et de diagramme de rayonnement que nous 

L’antenne planaire ou patch (en anglais) est une antenne plane dont l'élément 
surface conductrice généralement carrée, séparée d'un plan réflecteur 

réalisation ressemble à un circuit imprimé double 
favorable à une production industrielle. Elle peut être utilisée seule 

Les antennes planaires sont utilisées lorsqu'on veut réduire 
dessus d'un plan de masse, par 

portables de radiocommunications, sur les récepteurs 
Fi, en radioamateurisme et 

professionnelles. L'antenne patch en réseau actif est une 
des antennes radar à faisceau contrôlé, en 

pt d’antennes patch est apparu dans les années 50, mais le véritable développement 
e d’un circuit imprimé. 

ci peuvent être intégrés au plus près des circuits électroniques en occupant un volume 
. Leur principal avantage réside dans leur 

sont utilisées dans de nombreuses applications 

 



 

 

 
 Circuit ou antenne ? 
 
Nous savons que la propagation des ondes dans une ligne microruban s’effectue à la fois dans
le milieu diélectrique et dans l’air comme le montre la Figure 2.
 

 
         Figure II-2 : Lignes de champ électrique autour d’une ligne microruban
 
 
Du point de vue modélisation, les deux milieux sont remplacés par un unique milieu effectif
Caractérisé par une constante diélectrique relative 
 

                           
1 1

2 2
r r

reff

ε εε + −   = + +   
   

Remarque : Cette équation est donnée pour W/h>1.
La répartition des lignes de champs, qui s’étendent autour et dans la structure, 
essentiellement : 
-de la largeur W des circuits métallisés
-des caractéristiques du substrat à savoir sa constante diélectrique 
Le choix des valeurs de ces paramètres conditionne généralement le type d’application que
nous  pouvons  envisager en technologie microruban. Pour la réalisation de circuits
hyperfréquences, nous rechercher
on choisira en conséquence un substrat tel que l’énergie électromagnétique reste co
dans le diélectrique (plus exactement dans la cavité que forme la bande métallique et le plan 
de masse). Nous utiliserons donc des substrats à constante diélectrique élevée comme de
l’Alumine Ɛr =9.9 pour concevoir par exemple un amplificateur fai
En ce qui concerne les antennes, le substrat le mieux approprié est celui possédant une
constante diélectrique faible, une épaisseur grande par rapport à la longueur d’onde
d’opération et peu de pertes . Un substrat épais augmente la puissance r
réduit les pertes par effet Joules et améliore la bande passante de l’antenne. En
poids de la structure est augmenté. Une faible valeur de constante diélectrique
=2.5 favorise l’extension des champs autour de la ligne et donc la puissance
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Nous savons que la propagation des ondes dans une ligne microruban s’effectue à la fois dans
milieu diélectrique et dans l’air comme le montre la Figure 2. 

 

de champ électrique autour d’une ligne microruban

Du point de vue modélisation, les deux milieux sont remplacés par un unique milieu effectif
par une constante diélectrique relative effective exprimée par : 

1/2

1 1
1 12

2 2
r r h

w

ε ε
−

+ −    = + +    
    

 

Remarque : Cette équation est donnée pour W/h>1. 
La répartition des lignes de champs, qui s’étendent autour et dans la structure, 

de la largeur W des circuits métallisés. 
des caractéristiques du substrat à savoir sa constante diélectrique Ɛr et son épaisseur h

Le choix des valeurs de ces paramètres conditionne généralement le type d’application que
envisager en technologie microruban. Pour la réalisation de circuits

rechercherons à minimiser le rayonnement de la ligne en espace libre 
choisira en conséquence un substrat tel que l’énergie électromagnétique reste co

le diélectrique (plus exactement dans la cavité que forme la bande métallique et le plan 
donc des substrats à constante diélectrique élevée comme de

r =9.9 pour concevoir par exemple un amplificateur faible bruit.
En ce qui concerne les antennes, le substrat le mieux approprié est celui possédant une
constante diélectrique faible, une épaisseur grande par rapport à la longueur d’onde

. Un substrat épais augmente la puissance rayonnée
réduit les pertes par effet Joules et améliore la bande passante de l’antenne. En
poids de la structure est augmenté. Une faible valeur de constante diélectrique
=2.5 favorise l’extension des champs autour de la ligne et donc la puissance

: Antenne Patch 2013 

 

Nous savons que la propagation des ondes dans une ligne microruban s’effectue à la fois dans 

de champ électrique autour d’une ligne microruban. 

Du point de vue modélisation, les deux milieux sont remplacés par un unique milieu effectif 
 

La répartition des lignes de champs, qui s’étendent autour et dans la structure, dépend donc 

r et son épaisseur h. 
Le choix des valeurs de ces paramètres conditionne généralement le type d’application que 

envisager en technologie microruban. Pour la réalisation de circuits 
à minimiser le rayonnement de la ligne en espace libre 

choisira en conséquence un substrat tel que l’énergie électromagnétique reste concentrée 
le diélectrique (plus exactement dans la cavité que forme la bande métallique et le plan 

donc des substrats à constante diélectrique élevée comme de 
ble bruit. 

En ce qui concerne les antennes, le substrat le mieux approprié est celui possédant une 
constante diélectrique faible, une épaisseur grande par rapport à la longueur d’onde 

ayonnée par l’antenne, 
réduit les pertes par effet Joules et améliore la bande passante de l’antenne. En contrepartie, le 
poids de la structure est augmenté. Une faible valeur de constante diélectrique typiquement Ɛr 
=2.5 favorise l’extension des champs autour de la ligne et donc la puissance rayonnée. 



 

 

II-3.Structure  
 

Une antenne patch consiste en un élément métallique de forme quelconque 
(rectangulaire, Circulaire, à fente, ou formes plus élaborées) déposé sur 
substrat diélectrique qui présente sur l’autre face un plan
L’ antenne patch rectangulaire est
dessous : 
 

                            Figure II- 3 :
 
 
 Les dimensions du patch sont généralement de l’ordre de la demi
de la longueur est guidé par la fréquence de résonance à donner à l’antenne. Le plan de masse 
ne pouvant pas être infini, il peut être égal à trois
représente parfois un encombrement trop important. Un plan de masse plus petit conduira à 
une modification des propriétés de l’antenne. Les caractéristiques du substrat influent sur 
celles de l’antenne. En général, sa
négligeable devant la longueur d’onde et présenter
d’un diélectrique par la tangente des pertes notée tan d, u
alentours de 10-3). 
Différentes méthodes existent pour polariser une
est alimentée par une connexion coaxiale, le connecteur étant 
rayonnant. L’alimentation peut être apportée par une ligne micro ruban connectée sur un coté 
de l’antenne. La position du point de l’alimentation aura un impact non négligeable sur 
l’impédance d’entrée de l’antenne et donc sur son adaptation. 
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Une antenne patch consiste en un élément métallique de forme quelconque 
, à fente, ou formes plus élaborées) déposé sur 
présente sur l’autre face un plan conducteur (plan de masse). 

antenne patch rectangulaire est l’antenne patch la plus courante, sa structure est détaillée ci

: Structure d’une antenne patch rectangulaire 

Les dimensions du patch sont généralement de l’ordre de la demi-longueur d’onde. Le choix
de la longueur est guidé par la fréquence de résonance à donner à l’antenne. Le plan de masse 

fini, il peut être égal à trois ou quatre fois la longueur d’onde, ce qui 
un encombrement trop important. Un plan de masse plus petit conduira à 

propriétés de l’antenne. Les caractéristiques du substrat influent sur 
celles de l’antenne. En général, sa permittivité doit être faible, il doit être d’épaisseur 
négligeable devant la longueur d’onde et présenter de faible pertes (on caractérise les pertes 

ngente des pertes notée tan d, une valeur typique se situe aux 

Différentes méthodes existent pour polariser une antenne patch. Sur la figure
par une connexion coaxiale, le connecteur étant placé à l’intérieur de l’élément 

peut être apportée par une ligne micro ruban connectée sur un coté 
position du point de l’alimentation aura un impact non négligeable sur 

l’antenne et donc sur son adaptation.  

: Antenne Patch 2013 

 

Une antenne patch consiste en un élément métallique de forme quelconque 
, à fente, ou formes plus élaborées) déposé sur la surface d’un 

conducteur (plan de masse). 
ucture est détaillée ci-

 
 

longueur d’onde. Le choix 
de la longueur est guidé par la fréquence de résonance à donner à l’antenne. Le plan de masse 

ou quatre fois la longueur d’onde, ce qui 
un encombrement trop important. Un plan de masse plus petit conduira à 

propriétés de l’antenne. Les caractéristiques du substrat influent sur 
permittivité doit être faible, il doit être d’épaisseur 

de faible pertes (on caractérise les pertes 
typique se situe aux 

antenne patch. Sur la figure II- 3, l’antenne 
à l’intérieur de l’élément 

peut être apportée par une ligne micro ruban connectée sur un coté 
position du point de l’alimentation aura un impact non négligeable sur 



 

 

II-4.Les différentes formes d'une antenne
 
L’ antenne patch peut prendre plusieurs formes qui peuvent être rectangulaire, carré, circulaire
Ou simplement un dipôle. Ces formes sont les plus courantes car elles présentent une grande
Facilité d'analyse et de fabrication, mais égal
intéressant. 
 

                     
 
                       Carré                Rectangulaire 
 
 

                              
                               Elliptique   
 

Remarque : 
Parmis toutes ces formes, l’élément rectangulaire est sans contexte le plus facile à 
appréhender pour la compréhension des mécanismes de rayonnements des antennes planaires.
 

 II-5. Principe de fonctionnement
 

L’élément rayonnant le plus classique est un rectangle 
pour comprendre le fonctionnement d’une antenne patch et
analytiques de leur rayonnement et de leur impédance d’entrée. Une antenne
vue comme une ligne de transmission (ligne microruban) ouverte à chacune de ses
Ces deux discontinuités se comportent comme deux extrémités rayonnantes. La deuxième
manière de traiter une antenne patch est de la considérer comme une cavité réson
par le patch, le plan de masse et les quatre
considérée comme une capacité qui stocke des charges et dans laquelle un champ électrique 
uniforme est créé entre le patch et
le champ électrique est orienté selon l’axe

rester telle que :
4 1r

c
h

f ε
≤

−
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d'une antenne patch 

antenne patch peut prendre plusieurs formes qui peuvent être rectangulaire, carré, circulaire
simplement un dipôle. Ces formes sont les plus courantes car elles présentent une grande

d'analyse et de fabrication, mais également un diagramme de rayonnement très

Rectangulaire           Dipôle          Circulaire       

 
  Triangulaire      Anneau          Secteur de Disque

toutes ces formes, l’élément rectangulaire est sans contexte le plus facile à 
appréhender pour la compréhension des mécanismes de rayonnements des antennes planaires.

Principe de fonctionnement 

L’élément rayonnant le plus classique est un rectangle .Deux modèles sont utilisés 
pour comprendre le fonctionnement d’une antenne patch et déterminer des formules 
analytiques de leur rayonnement et de leur impédance d’entrée. Une antenne
ue comme une ligne de transmission (ligne microruban) ouverte à chacune de ses

discontinuités se comportent comme deux extrémités rayonnantes. La deuxième
manière de traiter une antenne patch est de la considérer comme une cavité réson

patch, le plan de masse et les quatre bords. En basse fréquence, la cavité peut être 
capacité qui stocke des charges et dans laquelle un champ électrique 

uniforme est créé entre le patch et le plan de masse. Tant que l’épaisseur du substrat est faible, 
le champ électrique est orienté selon l’axe z et indépendant de z. En pratique, l’épaisseur doit 

4 1−
. 

: Antenne Patch 2013 

 

antenne patch peut prendre plusieurs formes qui peuvent être rectangulaire, carré, circulaire 
simplement un dipôle. Ces formes sont les plus courantes car elles présentent une grande 

ement un diagramme de rayonnement très 

 

        Secteur d’anneau 

Secteur de Disque 

toutes ces formes, l’élément rectangulaire est sans contexte le plus facile à 
appréhender pour la compréhension des mécanismes de rayonnements des antennes planaires. 

modèles sont utilisés 
déterminer des formules 

analytiques de leur rayonnement et de leur impédance d’entrée. Une antenne patch peut être 
ue comme une ligne de transmission (ligne microruban) ouverte à chacune de ses extrémités. 

discontinuités se comportent comme deux extrémités rayonnantes. La deuxième 
manière de traiter une antenne patch est de la considérer comme une cavité résonante, formée 

bords. En basse fréquence, la cavité peut être 
capacité qui stocke des charges et dans laquelle un champ électrique 

que l’épaisseur du substrat est faible, 
z et indépendant de z. En pratique, l’épaisseur doit 
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Au fur et à mesure que la fréquence augmente, la distribution des charges sur le patch n’est 
plus uniforme, et celle du courant et du champ électrique dans le plan xy aussi. Un champ 
magnétique apparaît aussi. La distribution du champ électrique dans la cavité rectangulaire est 
donnée par l’équation suivante : 

               0
yxE E= =                 0 cos cosx

m x n y
E E

L W

π π   = =    
   

.            

 
Pour des fréquences particulières (fréquences de résonance de cavité) liées aux dimensions de 
la cavité rectangulaire, la distribution du champ électrique est telle que le rayonnement est 
optimisé. 

                         
2 2

,
2

m n

r

c m n
F

L Wπ ε
   = +   
   

 

Où m et n sont des entiers supérieurs ou égaux à 0, qui représentent les modes de cavités. Ces 
Modes caractérisent la distribution du champ électrique le long d’un axe de la cavité. Le mode 
fondamental est le mode (m,n) = (0,1) si W > L, indiquant que le champ électrique présente 
un minimum le long de l’axe parallèle à la largeur, et (m,n) = (1,0) si L > W, indiquant que le 
champ électrique présente un minimum le long de l’axe parallèle à la longueur. Cette formule 
est valable uniquement si la hauteur de la cavité est négligeable. Si ce n’est pas le cas, il 
faudra pendre en compte une troisième composante dans le mode de résonance. 
Prenons le cas où L > W et étudions la distribution du champ électrique dans la cavité.  
Lorsque la longueur L de la cavité est environ égale à λ/2, l’antenne entre en résonance, à la 
manière d’un dipôle demi onde. Le champ électrique est maximal et en opposition de phase 
aux deux extrémités séparées par L.  
Le long de l’axe Y (parallèle à W), le champ électrique est quasiment uniforme. Par contre, le 
champ électrique n’est pas uniforme le long de l’axe X (parallèle à L). Il présente un 
minimum et un maximum et passe par un zéro le long des extrémités séparées par W. 
Cette distribution de champ électrique est liée à une accumulation de charges de signes 
opposées sur les bords séparées par L et un courant orienté le long de l’axe X. 
 



 

 

                         Figure II-4 : Rayonnement d’une antenne patch rectangulaire
 

Le champ présent entre les bords du patch et le plan de masse va déborder et contribuer à
Générer le champ électromagnétique rayonné : ceux généré par les bords séparés par L étant 
maximum et en opposition de phase vont avoir tendance à s’additionner de manière 
constructive et optimale, et générer un rayonnemen
sont donc appelés bords rayonnants.
Ceux générés par les bords séparés par W présentant un zéro, ils ne vont pas contribuer au
rayonnement. Cependant, en raison de ce débordement du champ électrique, la résonance ne 
se fait pas parfaitement lorsque 
demi longueur d’onde, mais lorsque L =
pas trivial et repose soit sur un calcul
sur l’utilisation de méthodes numériques
analytiques sont facilement utilisables. Pour des
d’employer des méthodes numériques.
 
 
II-5-1. Mécanismes de rayonnemen
 

Le mécanisme de rayonnement d’une antenne patch rectangulaire se comprend 
aisément à partir de sa forme géométrique. Lorsque vous excitez la ligne d’alimentation avec 
une source RF, une onde électromagnétique va se 
l’élément rayonnant de largeur plus grande que la ligne, donc plus apte à rayonner. Une 
distribution de charge va s’établir à l’interface Substrat/Plan de masse, 
rayonnant. 
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Rayonnement d’une antenne patch rectangulaire

Le champ présent entre les bords du patch et le plan de masse va déborder et contribuer à
le champ électromagnétique rayonné : ceux généré par les bords séparés par L étant 

et en opposition de phase vont avoir tendance à s’additionner de manière 
générer un rayonnement inscrit dans le plan YZ. Ces deux

sont donc appelés bords rayonnants. 
Ceux générés par les bords séparés par W présentant un zéro, ils ne vont pas contribuer au

, en raison de ce débordement du champ électrique, la résonance ne 
parfaitement lorsque la fréquence est telle que la longueur du patch est égale à la 

d’onde, mais lorsque L = 0,49 λ. Le calcul des performances de l’antenne 
soit sur un calcul analytique et plusieurs hypothèses simplificatrices, soit 

ur l’utilisation de méthodes numériques exactes. Pour des géométries simples, les méthodes 
analytiques sont facilement utilisables. Pour des géométries plus complexes, il est nécessaire 
d’employer des méthodes numériques. 

Mécanismes de rayonnement de l’antenne patch rectangulaire  

Le mécanisme de rayonnement d’une antenne patch rectangulaire se comprend 
partir de sa forme géométrique. Lorsque vous excitez la ligne d’alimentation avec 
RF, une onde électromagnétique va se propager sur cette ligne puis va rencontrer 

rayonnant de largeur plus grande que la ligne, donc plus apte à rayonner. Une 
charge va s’établir à l’interface Substrat/Plan de masse, sur et sous

: Antenne Patch 2013 

 

 
Rayonnement d’une antenne patch rectangulaire. 

Le champ présent entre les bords du patch et le plan de masse va déborder et contribuer à 
le champ électromagnétique rayonné : ceux généré par les bords séparés par L étant 

et en opposition de phase vont avoir tendance à s’additionner de manière 
t inscrit dans le plan YZ. Ces deux bords 

Ceux générés par les bords séparés par W présentant un zéro, ils ne vont pas contribuer au 
, en raison de ce débordement du champ électrique, la résonance ne 

la fréquence est telle que la longueur du patch est égale à la 
calcul des performances de l’antenne n’est 

analytique et plusieurs hypothèses simplificatrices, soit 
exactes. Pour des géométries simples, les méthodes 

géométries plus complexes, il est nécessaire 

 

Le mécanisme de rayonnement d’une antenne patch rectangulaire se comprend 
partir de sa forme géométrique. Lorsque vous excitez la ligne d’alimentation avec 

propager sur cette ligne puis va rencontrer 
rayonnant de largeur plus grande que la ligne, donc plus apte à rayonner. Une 

sur et sous l’élément 



 

 

La Figure II-5 montre cette distribution dans le cas particulier ou l’antenne rayonne le
efficacement c’est à dire lorsqu’elle devient 
un multiple de la demi-longueur d’onde guidée. Le cas présenté correspond
fondamental de l’antenne. Ces distributions de charge et les densités de courant
induisent une distribution de champ électrique représentée à la Figure 6 (toujours
mode fondamental). Une analyse plus détaillée des distributions de charge 
électrique permet de retrouver tous les paramètres caractéristiques d’une antenne :
Diagramme de rayonnement et résistance de rayonnement, fréquences de résonance.
 
 

                          
          Figure II-5 : Distribution 
 

                               
 
Figure II-6 : Distribution de la composante verticale E z du champ électrique entre le patch et 
le plane de masse dans le mode fondamental de l’antenne (L 
avec la ligne d’alimentation sur le côté W)
 
Nous pouvons constater sur la Figure 8
Verticales du champ électrique sur la longueur L de l’antenne. Ce résultat est évident en 
même car il correspond au cas de la résonance 
La Figure 7 montre les composantes horizontales des lignes de champ entourant
imprimé. Contrairement à précédemment, elles créent des rayonnements qui sont en
dans le plan de l’antenne, le rayonnement du patch peut être modélisé par celui de
parallèles couplées distantes de la longueur L et de dimensions W*h. 
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ntre cette distribution dans le cas particulier ou l’antenne rayonne le
efficacement c’est à dire lorsqu’elle devient résonante : la longueur de l’élément 

longueur d’onde guidée. Le cas présenté correspond
fondamental de l’antenne. Ces distributions de charge et les densités de courant
induisent une distribution de champ électrique représentée à la Figure 6 (toujours
mode fondamental). Une analyse plus détaillée des distributions de charge 
électrique permet de retrouver tous les paramètres caractéristiques d’une antenne :

et résistance de rayonnement, fréquences de résonance.

 
: Distribution de charge et densités de courant sur une antenne microruban

 

de la composante verticale E z du champ électrique entre le patch et 
plane de masse dans le mode fondamental de l’antenne (L longueur résonante et on attaque

avec la ligne d’alimentation sur le côté W). 

ouvons constater sur la Figure 8 un renversement de phase des composantes
du champ électrique sur la longueur L de l’antenne. Ce résultat est évident en 

car il correspond au cas de la résonance ʎg /2 de l’antenne. 
montre les composantes horizontales des lignes de champ entourant

imprimé. Contrairement à précédemment, elles créent des rayonnements qui sont en
le rayonnement du patch peut être modélisé par celui de

parallèles couplées distantes de la longueur L et de dimensions W*h.  

: Antenne Patch 2013 

 

ntre cette distribution dans le cas particulier ou l’antenne rayonne le plus 
élément rayonnant est 

longueur d’onde guidée. Le cas présenté correspond au mode 
fondamental de l’antenne. Ces distributions de charge et les densités de courant associées 
induisent une distribution de champ électrique représentée à la Figure 6 (toujours pour le 
mode fondamental). Une analyse plus détaillée des distributions de charge et du champ 
électrique permet de retrouver tous les paramètres caractéristiques d’une antenne : 

et résistance de rayonnement, fréquences de résonance. 

 
de charge et densités de courant sur une antenne microruban. 

 

de la composante verticale E z du champ électrique entre le patch et 
longueur résonante et on attaque 

un renversement de phase des composantes 
du champ électrique sur la longueur L de l’antenne. Ce résultat est évident en lui 

montre les composantes horizontales des lignes de champ entourant l’élément 
imprimé. Contrairement à précédemment, elles créent des rayonnements qui sont en phase 

le rayonnement du patch peut être modélisé par celui de deux fentes 



 

 

                                                   
 Figure II-7 : Distribution de la composante horizont
fondamental de l’antenne. 

                                
    Figure II-8 : Modélisation de l’antenne patch rectangulaire par deux fentes parallèles 
couplées. 
 
Si nous nous intéressons maintenant à la distribution des charges, nous pourrions
l’étude des composantes tangentielles du champ magnétique que le patch
modéliser comme une cavité avec 
murs électriques formés par les métallisations (
normale du champ électrique est constante).
En posant les équations de propagations avec les conditions aux limites adéquates, on
détermine toutes les fréquences
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Avec : 

           effW W W= + ∆  

          effL L L= + ∆  
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Distribution de la composante horizontale du champ électrique dans le 

 
Modélisation de l’antenne patch rectangulaire par deux fentes parallèles 

essons maintenant à la distribution des charges, nous pourrions
l’étude des composantes tangentielles du champ magnétique que le patch rectangulaire peut se 
modéliser comme une cavité avec quatre murs magnétiques (les bords de la

rmés par les métallisations (en prenant l’approximation que
normale du champ électrique est constante). 
En posant les équations de propagations avec les conditions aux limites adéquates, on
détermine toutes les fréquences de résonances d’une antenne patch rectangulaire :

2 2

eff eff

c m n

W Lπ π
   

= +      
   

 

: Antenne Patch 2013 

 

ale du champ électrique dans le mode 

 
Modélisation de l’antenne patch rectangulaire par deux fentes parallèles 

essons maintenant à la distribution des charges, nous pourrions montrer par 
rectangulaire peut se 

murs magnétiques (les bords de la cavité) et deux 
l’approximation que la composante 

En posant les équations de propagations avec les conditions aux limites adéquates, on 
de résonances d’une antenne patch rectangulaire : 



 

 

∆L et ∆W représentent respectivement les extensions de longueur et de 
Débordement du champ avec ∆
Dans la formule. 
 
II-6.Diagramme de rayonnement et polarisation
 

Le rayonnement d’une antenne
orienté dans l’axe x. La polarisation du champ rayonnée est rectiligne. Le rayonnement est 
dépendant de θ et f. Il est concentr
= 0°). En raison du plan de masse, le rayonnement ne se fait que
du plan de masse. La figure II-
                                                
                                 

     

    Figure II-9 : Diagramme de rayonnement d’une antenne patch rectangulaire
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ésentent respectivement les extensions de longueur et de largeur dues au
du champ avec ∆W qui s’obtient en remplaçant la largeur W par la longueur L

de rayonnement et polarisation  

Le rayonnement d’une antenne patch rectangulaire est similaire à celui d’un dipôle 
orienté dans l’axe x. La polarisation du champ rayonnée est rectiligne. Le rayonnement est 

 et f. Il est concentré dans un lobe principal orienté vers la verticale du patch (
du plan de masse, le rayonnement ne se fait que dans le demi

-9 illustre le diagramme de rayonnement de cette antenne
 

Diagramme de rayonnement d’une antenne patch rectangulaire

: Antenne Patch 2013 

 

largeur dues au 
çant la largeur W par la longueur L 

patch rectangulaire est similaire à celui d’un dipôle 
orienté dans l’axe x. La polarisation du champ rayonnée est rectiligne. Le rayonnement est 

orienté vers la verticale du patch (θ 
ans le demi-plan au dessus 

cette antenne. 

 

Diagramme de rayonnement d’une antenne patch rectangulaire 



 

 

Remarque : antenne patch à polarisation circulaire
Les antennes patchs n’ont pas tout
méthodes d’alimentation, il est possible de leur donner une polarisation elliptique ou 
circulaire. Par exemple, en introduisant des fentes dans l’antenne
 
II-7. Impédance d’entrée et bande passante
 

L’impédance d’entrée d’une antenne patch est assez difficile à 
nombreuses formules approchées existent pour l’évaluer. L’impédance d’entrée dépend de 
plusieurs paramètres, tels que la constante diélectrique, l’épaisseur et la largeur du substrat, 
ainsi que de la position du point d’alimentation. Les équ
déterminer approximativement la résistance d’entrée d’une antenne patch rectangulaire :
 

      
1

1

2inR
G

= ,
2

1 2
090

W
G

λ
= si 

W

λ
           
 L’effet de la position du point d’alimen
polarisation au milieu du patch conduit
du rayonnement. 
 

                                pos inR R x arc= ⇔ =

   

                                       

   Figure II-10 : Variation de la résistance d’entrée d’une antenne patch rectangulaire en 
fonction de la position du point d’alimentation
 
La bande passante d’une antenne patch est relativement faible, seulement quelques % de la 
fréquence centrale. Pour accroître la bande passante, il est possible d’augmenter l’épaisseur 
du substrat pour réduire le facteur de qualité de la cavité résonante (tout en co
substrat suffisamment fin pour conserver l’effet de cavité). Il est aussi possible de modifier la 
méthode d’alimentation du patch, ou couplages entre antennes résonantes (deux patches 
superposés). 
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Remarque : antenne patch à polarisation circulaire 
n’ont pas toutes une polarisation rectiligne. Selon leur structure et 

, il est possible de leur donner une polarisation elliptique ou 
exemple, en introduisant des fentes dans l’antenne.  

Impédance d’entrée et bande passante  

L’impédance d’entrée d’une antenne patch est assez difficile à 
nombreuses formules approchées existent pour l’évaluer. L’impédance d’entrée dépend de 
plusieurs paramètres, tels que la constante diélectrique, l’épaisseur et la largeur du substrat, 
ainsi que de la position du point d’alimentation. Les équations ci-dessous permettent de 
déterminer approximativement la résistance d’entrée d’une antenne patch rectangulaire :

0

1
W

λ
≪ ,

2

1 2
0120

W
G

λ
=  si 

0

1
W

λ
≫ . 

L’effet de la position du point d’alimentation peut être pris en compte.
polarisation au milieu du patch conduit à une impédance d’entrée nulle et à une dégradation 

2cos cos pos
pos in

in

Rx L
R R x arc

L R

π
π

  = ⇔ =        
 

 

de la résistance d’entrée d’une antenne patch rectangulaire en 
fonction de la position du point d’alimentation. 

passante d’une antenne patch est relativement faible, seulement quelques % de la 
fréquence centrale. Pour accroître la bande passante, il est possible d’augmenter l’épaisseur 
du substrat pour réduire le facteur de qualité de la cavité résonante (tout en co
substrat suffisamment fin pour conserver l’effet de cavité). Il est aussi possible de modifier la 

patch, ou couplages entre antennes résonantes (deux patches 

: Antenne Patch 2013 

 

leur structure et leurs 
, il est possible de leur donner une polarisation elliptique ou 

L’impédance d’entrée d’une antenne patch est assez difficile à calculer et de 
nombreuses formules approchées existent pour l’évaluer. L’impédance d’entrée dépend de 
plusieurs paramètres, tels que la constante diélectrique, l’épaisseur et la largeur du substrat, 

dessous permettent de 
déterminer approximativement la résistance d’entrée d’une antenne patch rectangulaire : 

tation peut être pris en compte. placer le point de 
à une impédance d’entrée nulle et à une dégradation 

de la résistance d’entrée d’une antenne patch rectangulaire en 

passante d’une antenne patch est relativement faible, seulement quelques % de la 
fréquence centrale. Pour accroître la bande passante, il est possible d’augmenter l’épaisseur 
du substrat pour réduire le facteur de qualité de la cavité résonante (tout en conservant un 
substrat suffisamment fin pour conserver l’effet de cavité). Il est aussi possible de modifier la 

patch, ou couplages entre antennes résonantes (deux patches 



 

 

 
II-8.Les techniques d'alimentations
  
II-8-1.Alimentation par sonde coaxiale
dont l’antenne est intégrée dans le dispositif.
 

 

                        
                        Figure II-11: Alimentation du patch rectangulaire avec un câble coaxiale
   
                              
L'alimentation coaxiale où le conducteur intéri
externe au plan de masse est également largement utilisée. Ce type
mettre en œuvre et à adapter. Mais il offre une bande passante
Parmi ces caractéristiques : 
-Pas de pertes par rayonnement de ligne
-Obtention de l’impédance d’entrée par positionnement de la sonde
-Technique de perçage simple.
 
II-8-2.Alimentation par ligne microruban
Dans ce cas d’alimentation, on relie une ligne microstrip au patch. Cette ligne lui amène de
L’ énergie. Il existe cependant
un rayonnement parasite. 
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'alimentations  

sonde coaxiale : L’alimentation de l’antenne dépend de la manière 
dont l’antenne est intégrée dans le dispositif. 

 

: Alimentation du patch rectangulaire avec un câble coaxiale

L'alimentation coaxiale où le conducteur intérieur est attaché au patch et le
externe au plan de masse est également largement utilisée. Ce type d'alimentation est facile à 

et à adapter. Mais il offre une bande passante étroite. 

rayonnement de ligne. 
entrée par positionnement de la sonde. 
. 

Alimentation par ligne microruban   
alimentation, on relie une ligne microstrip au patch. Cette ligne lui amène de

énergie. Il existe cependant un inconvénient dans ce type d’alimentation vu qu’

: Antenne Patch 2013 

 

de l’antenne dépend de la manière 

                                                       
: Alimentation du patch rectangulaire avec un câble coaxiale. 

eur est attaché au patch et le Conducteur 
d'alimentation est facile à 

alimentation, on relie une ligne microstrip au patch. Cette ligne lui amène de 
un inconvénient dans ce type d’alimentation vu qu’elle génère 



 

 

                                    
               Figure II-12: Alimentation du patch rectangulaire par une ligne 

 
II-8-3.Alimentation par le couplage par proximité
 
Ce type d’alimentation offre la meilleure bande passante, il est facile à modéliser et présente 
un rayonnement parasite faible. La distance entre la ligne d'alimentation et le patch peut être
utilisée pour adapter l'impédance de l'antenne.
Le principal inconvénient de ce type d'alimentation est qu'il est difficile à mettre en œuvre.
 

    
                         Figure II-13: Alimentation du patch rectangulaire par couplage
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: Alimentation du patch rectangulaire par une ligne microruban

par le couplage par proximité  

Ce type d’alimentation offre la meilleure bande passante, il est facile à modéliser et présente 
un rayonnement parasite faible. La distance entre la ligne d'alimentation et le patch peut être
utilisée pour adapter l'impédance de l'antenne. 
Le principal inconvénient de ce type d'alimentation est qu'il est difficile à mettre en œuvre.

: Alimentation du patch rectangulaire par couplage

: Antenne Patch 2013 

 

 
microruban. 

Ce type d’alimentation offre la meilleure bande passante, il est facile à modéliser et présente 
un rayonnement parasite faible. La distance entre la ligne d'alimentation et le patch peut être 

Le principal inconvénient de ce type d'alimentation est qu'il est difficile à mettre en œuvre. 

 
: Alimentation du patch rectangulaire par couplage. 



Chapitre II : Antenne Patch 2013 

 

 

45 

 

II-9.Avantages et limitations des antennes patch  

Les antennes microrubans présentent de nombreux avantages comparées aux antennes 
micro-ondes classiques. De plus,elles sont opérationnelles sur un large domaine de fréquence 
100MHz à 100 GHz.On peut énumérer les avantages suivants : 
Faible poids, encombrement réduit, conformations possibles. 
Faible coût de fabrication, production en masse facile. 
Rayonnement en polarisation linéaire et circulaire possibles. 
Antennes multibandes, multipolarisations. 
Compatibilité avec les circuits hybrides (composants discrets rapportés sur le substrat) et 
les MMIC (Microwave Monolithic Integrated Circuit, composants intégrés dans les substrats 
AsGa ou Si). 
Réseaux d’alimentation et d’adaptation fabriqués simultanément avec l’antennen. 
 
Toutefois, les antennes microruban ont également des limitations que ne présentent pas les 
antennes traditionnelles : 
Bande passante étroite, souvent associée avec les problèmes de tolérances de fabrication 
Généralement faible gain (6 dB). 
Sur un grand plan de masse, ces antennes rayonnent uniquement dans le demi-plan. 
Supportent uniquement des faibles puissances (<100 W). 
Pertes de rayonnement par ondes de surfaces dans le substrat diélectrique. 
 
II-10.Conclusion  
Notre objectif de cette présentation et de se familiarisé avec cette antenne et de connaitre ses 
caractéristiques tel que le diagramme de rayonnement que nous essayerons de simuler  et de 
voir tout ses résultats théoriques en pratique et d’être apte de vérifier les résultats de la 
simulation a l’aide du logiciel de simulation HFSS (High Frequency Structure of Simulation) 
que nous allons présenter dans le chapitre qui suit.  
 
 

 

 



 

 

 

 Chapitre III 
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III-1.Introduction  

 

Ce chapitre nous allons le consacrer uniquement  pour la présentation du logiciel HFSS (High 

Frequency Structure Simulator), ses fonctionnalités et présenter de façon générale le rôle de 

chaque fonction que nous allons utiliser pour réaliser nos simulations. 

Et aussi s’accentuer sur  les étapes à suivre  pour créer un projet ; vu que leur hiérarchie est 

très importante pour obtenir des résultats. 

 

III -2.Définition du logiciel  

 

HFSS (High Frequency Structure Simulator) est un outil performant à onde électromagnétique  

Commercial qui fait la simulation du champ d’un model arbitraires en 3D. Il intègre la 

simulation, visualisation, modélisation des solides, et l'automatisation dans un environnement 

facile à utiliser où les solutions des problèmes EM 3D sont obtenues rapidement et avec 

précision. HFSS emploie la méthode des éléments finis (FEM), Ansoft HFSS peut être utilisé 

pour calculer des paramètres tels que Paramètres S, fréquence de résonance, et des champs 

électriques et magnétiques En champ proche comme en champ lointain.  

Qu’est ce que nous donne HFSS ? 

Prototypes virtuel et rapide 

Structures Arbitraire en 3D 

Plusieurs ports / Modes multiples 

Supporte tous les matériaux à micro-ondes 

Calcul  des paramètres S, Y, Z. 

 

III -3.Installation du HFSS : 

 

Pour installer HFSS il suffit de commencer par double clic sur Autorun 
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Installer dans un premier temps HFSS, cliquez une seule fois sur Install HFSS 

 

 

Et suivre les étapes : 
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Pour ajouter la bibliothèque : clique sur Install Libraries 

Et suivre les étapes : 
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Remarque : L’installation de la bibliothèque est indispensable pour le bon fonctionnement du 

logiciel. 

Maintenant vous pouvez accéder à HFSS en cliquant sur l’icône  et cette page apparait 

sur vos écrans : 

 

 

III -4.Description générale des outils HFSS  
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III -1. Barre des outils Elle englobe tous les outils pour créer un model : 

 Rotation et zoom du model  

 Type du matériau utilisé  

 Le plan dans lequel on dessine l’objet  

 Raccourci des modèles du carré jusqu’au cône :  

 Sélectionner une face :  

 

III -2.Fenêtre des modèles 3D  

 

 
 

III -3.Gestionnaire de projet arborescent (Manager des projets) 
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III -4.Fenêtre des propriétés : elle  nous permet d’attribuer le nom, le matériau, la couleur 

…etc.  

 
 

Commandes : on trouve la position et les paramètres (hauteur, largeur) du model, on peut les 

modifiés à n’importe quel moment durant le travail. 
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III -5-.Barre des menus : Elle contient toutes les options d’HFSS notamment : 

 HFSS>>Edit : 

 

 Arrange > 

 

 Move : translater un élément de la structure le long d’un vecteur. 

 

 Rotate : déplacer un élément de la structure par un angle. 

 

 Mirror : faire translater un objet choisi autour d'un plan spécifié. 

 

 Offset: Effectue une échelle uniforme en x, y et z. 

 

 Duplicate> 

 

 Along lines : Créer des copies multiples d’un objet le long d'un vecteur. 

 

 Around axis : créer des copies multiples d’un objet en rotation par un angle fixe autour de x, 

y ou z. 

 

 Mirror : Fixer l’image d’un objet autour d'un plan spécifié et créer son double. 

 

 Draw : Regroupe tous les modèles, rectangle, ellipse, cercle, boite….. 
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 Modeler/3D Modeler :  

 

On trouve boolean (fusionner deux objets), unité a utilisée (mm,cm,km…), measures (mesurer 

les distances), coordinate system (les coordonnées à utilisés) 

 mode analysis :(analyse les propriétés et les performances des objets, des surfaces). 

 Coordinate system : nous permet de changer le système des coordonnés dans lequel on va 

travailler. 

 Units : choisir l’unité de mesure (in,mm,cm,….) 

 

 

                               

 

 

HFSS : contient les fonctionnalités principales : 
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 Solution Type (type de la solution): 

 

 Driven Modal : calcule des paramètres S, les solutions de la matrice S seront exprimées en 

termes de puissance incidente et réfléchie. 

 

 Driven Terminal : calcule les paramètres S de ports multiconducteurs de la ligne de 

transmission. 

 Les solutions de la matrice S seront exprimées en termes de tensions et des courants aux 

bornes. 

 

 Eignemode : calcule les modes propres, ou de résonances d'une structure. La solution des 

modes propre retourne les fréquences de résonance de la structure et les champs à ses 

fréquences de résonance. 
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 Validate :         (compiler le projet) si tout est bon la fenêtre ci-dessous apparait : 

 

                       
 

Pour voir s’il ya des erreurs ou des warnings veuillez consultez  le message manager qui se 

trouve en bas de la fenêtre.  

  

 Analyze all :  ça prendra de 5-20min pour faire l’analyse ça dependra de votre 

machine. 

Une barre de progression va paraitre en rouge à la fin de l’analyse  vous aurez ce message : 
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Boundaries (conditions aux limites)  

 

 

 
 

 

 Perfect E : également appelé conducteur parfait ce type de limite le champ électrique est 

perpendiculaire à la surface. Il y a également deux affectations définissant un conducteur 

automatiquement parfait. 

 Toute surface de l'objet qui touche le fond est automatiquement définie comme une limite 

parfaitement conductrice et donné le nom de condition aux limites extérieures. 

 Tout objet assigné par un matériel PEC (Perfect Electric conductor) il est automatiquement 

attribué à la condition aux limites électriquement parfait. 

 

 

 Perfect H : est un conducteur magnétiquement parfait, il est tangentiel à la surface du 

champ E. 

 

 

 Finite Conductivity : limite de conductivité finie, vous permet de définir la surface d'un 

objet comme un conducteur avec perte (imparfait). 

 

 Impedance : surface résistive qui calcule le comportement des champs et des pertes en 

utilisant des formules analytiques(Rs+jXs). Avec Rs : résistance, Xs : réactance. 
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 Layered Impedance : plusieurs couches minces dans une structure peuvent être modélisées 

comme une surface d’impédance. 

 

 Lumped RLC : une combinaison en parallèle des résistances localisées, inductance, et /ou 

de la surface du condensateur, la simulation est similaire à celle d’une impédance. 

 

 Radiation : limites de rayonnement, aussi appelé frontières absorbantes, vous permettent de 

modéliser une surface électriquement ouverte: ondes peuvent alors sortir de la structure et 

s’arrêter vers la limite du rayonnement. 

 

 Excitations  

 

 

  

 Wave Port /Lumped Port: 

 Les ports d'ondes ont pour rôle d’indiquer la zone ou l'énergie rentre et sort du conducteur 

comme une alternative à l'utilisation de port d'onde (wave port) et vous pouvez appliquer 

ports localisés (Lumped port) à une structure, il applique une excitation interne utile au sein 

d'une  structure. 

 

 Analyze Setup: les conditions d’analyse notamment la fréquence et son intervalle 

d’utilisation. 
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 Add Solution Setup : 
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III -5.Comment créer un projet  

Chaque projet passe de trois étapes essentielles : 

 

 Création et configuration initial 

 Dessin du model 

 Compilation et visualisation des résultats 

 

1-Création du projet file>> new, insertion du HFSS design pour cela clique droit sur le 

projet et sélectionnez Insert>>insert HFSS design. 

 

 
 

 

 Enregistrer avant de commencer à dessiner dans n’importe quel dossier. 

 

2-Configuration initiale : avant de commencer à établir le model il faut s’avoir d’avance la 

solution voulue (HFSS>>solution type) qui dépend de l’application pour cela il y a trois 

choix : 

 

 Driven Modal 

 

 Driven Terminal 

 

 Eignemode 

 

Unité de travail Modeler>>units (mm, in, nm…) 

Et attribuer  les variables qu’on va utiliser  HFSS>>design properties: 

 



Chapitre III : Présentation du logiciel HFSS 2013 
 

 
60 

 

 

HFSS s'appuie sur des variables pour tout le paramétrage / optimisation au sein du projet. 

Les variables ont également de nombreux autres avantages qui les rendent nécessaires pour 

tous les projets. 

• Rapports fixes (longueur, largeur, hauteur) sont facilement maintenus en utilisant des 

variables. 

• Optimetrics : utiliser des variables pour optimiser la conception selon les critères définis par 

l'utilisateur. 

• Toutes les dimensions peuvent être rapidement changées dans une fenêtre. 

 

Dessin du model : cette partie englobe la conception et le paramétrage du model : 

Pour établir un model il faut allez à Draw>>choix du model 

 

 
 

Paramétrage : chaque objet a ses propres paramètres modifiables : 
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Compilation et visualisation des résultats  
 

Apres avoir dessiné le model avec les conditions au bord et l’excitation il faut compiler et 

analyser le projet   puis il faut aller aux résultats clique  droit sur results et choisir ce que 

vous voulez visualiser (diagramme de rayonnement, coefficient de réflexion, gain …) 

Exemple :(HFSS>Results>Solution Data) : 
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 Add frequency sweep  

 

                               
 

 

 

  

 Discrete : effectue une solution complète à toutes les fréquences en utilisant le maillage 

actuel, le temps requis est la fréquence à résoudre fois le nombre de points de fréquences ainsi 

que le champ peut être affiché à n'importe quelle fréquence dans la plage de balayage. 

 

 Fast : extrapolé un ensemble d’informations dans une bande passante autour de la 

fréquence centrale. Le temps et la mémoire nécessaire pour résoudre un balayage de 

fréquences peut être beaucoup plus grand qu’une seule fréquence à résoudre. 

 

 Interpolating : effectue une résolution à des points de fréquences discrètes qui sont adaptés 

par interpolation. 
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 Frequency Setup : la fréquence du travail. 

 

 Linear Step: spécifier une plage linéaire des valeurs avec un pas constant. 

 

 LinearCount : spécifier une plage linéaire des valeurs. 

 

 Star et Stop : Désigne l’intervalle de fréquence afin de calculer les fréquences de 

résonance. 

 

 Fields (visualiser le champ E et H le long du dispositif) : 
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Exemple : Représentation du champ Electrique d’une antenne patch : 

 

              

 

 Radiations  

 

Définir la forme du champ proche (Near field) (ligne ou sphère) ou  du champ lointain (Far 

field) (sphère), 

Cette partie est consacrée au calcul des paramètres d’une antenne qui nécessite une 

configuration particulière de calcul pour déterminer la  région au cours de laquelle les champs 

doivent être calculés : 

 

Sélectionner HFSS>>Radiation>>Insert Far Field Setup>>Infinite Sphere 
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Entrez les valeurs et le pas à suivre pour theta et Phi. 

 

 Résultats  

C’est la rubrique la plus intéressante parmi toutes les fonctionnalités du HFSS, 

Les données de traçage peuvent prendre diverses formes. Le format le plus souvent utilisé est 

le Tracé cartésien en 2D, mais nous avons aussi la possibilité de tracer en 3D. 

                

 
 

 Create modal Solution Data Report : cette partie est consacré pour l’affichage ou la 

visualisation des paramètres de l’antenne en 2D ou 3D (S, Y, Z, TOS, Gamma…). 
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Prenons l’exemple de rectangular Plot : pour visualiser il suffit de choisir le paramètre et son 

unité (db,re,im,ang…) et cliquer sur New Report. 

 

     

 

 Remarque : les paramètres S avec un seul port indique le coefficient (que S11)  de 

réflexion ce qui est fortement lier à la fréquence de résonnance. 
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Or  S11 dépend de la fréquence et TOS, alors on cherche dans l’allure les points ou le TOS est 

minime ce qui signifie le maximum d’énergie transmise. 

        

                  Figure 1: Représentation du VSWR(TOS) en fonction de la fréquence. 

 

 Remarque : m1 point ou aura lieu la fréquence de résonnance. 

 

Create Fields Report/Create Far Fields Report: 

 

 

Dans les ondes électromagnétiques, chaque paramètre dépend de R,θ,f donc il faut définir le 

champ lointain sous forme d’une sphère HFSS>>Radiation>>Insert Far Field Setup>>Infinit 

Sphere 

Exemple Create Far Fields Report>>Radiation Pattern: 
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Figure 2 : Le diagramme de rayonnement de la directivité en Phi=0°et Phi=90° 
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                              Figure 3:Représentation 3D polar du Gain en phi=0 et phi=90 

 

III- 6.conclusion  

Nous avons vue brièvement comment utiliser le logiciel HFSS, descriptions des outils 

générales : barre d’outils, barres des menus, fenêtre, Manager des projets ou toutes les 

rubriques sont classées par ordre d’exécution, ce qui s’simplifie la procédure de la conception 

du model au  assignements des conditions aux limites, et l’attribution des excitations ,contient  

aussi une rubrique analyse pour analyser la configuration l’icône résultat d’où on peut créer 

les rapports et les affichés sur la fenêtre des modèles. Après cette description nous serons 

aptes à réaliser nos projets c’est ce que nous verrons dans le quatrième chapitre. 

 



 

 

 

  Chapitre IV 
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IV-1.Introduction  

Dans ce chapitre nous allons voir en détail les étapes 
prend pour exemple l’antenne dipôle,
microruban, l’antenne patch alimenté
diélectrique, et l’antenne cornet
la puissance de HFSS par la construction
notes suivantes sauront fournir
Navigation générale des menus du logiciel
Affectation des variables. 
Vue d'ensemble des commandes utilisées pour
Une bonne conception et mise en œuvre de
Configuration de l'analyse. 
Création rapports  et visualisation des résultats
des paramètres s, y, z et des graphes qui nous aide à déterminer la valeur exacte de 
l’impédance d’entrée pure…).

IV -2.Antenne dipôle  
L’antenne dipôle est couramment utilisé
les communications sans fil en raison de leur

IV -2-1. HFSS starting 

Clique sur HFSS 11  
 Ou Double-clique sur l'icône HFSS 11 sur le Bu
 
IV -2-2. Création du projet 
Premier lancement de HFSS Simulator.

 

De la fenêtre du gestionnaire de projet.
le nom  dipôle. 
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voir en détail les étapes que nous allons suivre
l’antenne dipôle, l’antenne patch triangulaire alimenté 

alimenté par un câble coaxial, RDA  l’antenne à résonateur 
et l’antenne cornet. Ces exemples permettront d'illustrer à la fois

la construction et la simulation de ces structures d'antennes
r un bref résumé des objectifs: 

menus du logiciel, barres d'outils et touches rapides.

commandes utilisées pour créer des structures. 
mise en œuvre de limites. 

visualisation des résultats (obtenir un diagramme de rayonnement, calcul 
des paramètres s, y, z et des graphes qui nous aide à déterminer la valeur exacte de 

. 

couramment utilisé pour la radiodiffusion cellulaire ; Les téléphones
en raison de leur propriété omnidirective. 

 
sur l'icône HFSS 11 sur le Bureau Windows. 

 
HFSS Simulator. 

de projet. Clique-droit sur le fichier de projet 
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que nous allons suivre pour simuler. On 
 par une ligne 

l’antenne à résonateur 
à la fois la simplicité et 

ces structures d'antennes. Les 

rapides. 

(obtenir un diagramme de rayonnement, calcul 
des paramètres s, y, z et des graphes qui nous aide à déterminer la valeur exacte de 

Les téléphones et 

 

 et Enregistrer sous  
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IV-2-3. Travailler avec les géométries
Pour commencer à travailler avec l
Nous devons  insérer une conception HFSS. Clique
  > Insert HFSS design  du menu.

 

En raison de la nature de cette conception
solution. Dans le menu HFSS 
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géométries  
avec les géométries. 

rer une conception HFSS. Clique-droit sur le fichier de projet
du menu. 

de cette conception, nous allons utiliser Driven Modal
 select solution type puis  Driven Modal. 
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droit sur le fichier de projet 

 

Modal comme type de 
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Les unités sont choisies en mm

              

Clique  sur la rubrique HFSS et  on sélectionne

                                                    
Et ça va entrainer l’ouverture d’une fenêtre appelée table des 
tels que la longueur, la hauteur,
chaque ajout et s’assurer de l’attribution des unités.
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mm en choisissant la rubrique 3D modeler et units 

la rubrique HFSS et  on sélectionne Design properties au bas du menu.

                                                     
a va entrainer l’ouverture d’une fenêtre appelée table des variables, ajouter 

la hauteur, le rayon…en  ajoutant  une par une en cliquant sur add a 
l’attribution des unités. 
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units du menu. 

 
au bas du menu. 

variables, ajouter  les variables 
n cliquant sur add a 
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Dans cet exemple voici les variables

          

IV -2-4.Dessiner le dipôle  

On commence par créer l’éléme
d’outils :  
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Dans cet exemple voici les variables à ajouter: 

nce par créer l’élément dipôle en cliquant sur Draw cylinder 
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 de la barre 
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Par défaut la table des propriétés
position et la taille de l’objet peu
transparence.   

                

                  

                 

Nommé dip1, matériel PEC (Perf
La prochaine étape est de construire la symétrie du dip1, pour faire cela
l’objet dip1 sélectionnez  Edit 
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propriétés apparait une fois qu’on termine de dessiner l’objet,
position et la taille de l’objet peuvent  être modifiés via cette table ainsi que sa couleur et 

dip1, matériel PEC (Perfect Electric Conductor), clique sur OK 
construire la symétrie du dip1, pour faire cela clique
Edit -> Duplicate -> Around Axis. 
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’on termine de dessiner l’objet, la 
ainsi que sa couleur et sa 

 

 

 

clique-droit sur 
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La structure du dipôle est illustrée
        

 
IV -2-5. Créer le port d’excitation
 
Dans cette section nous allons créer la source
milieu du dipôle pour assigner
puis on clique sur Draw rectangle et cho
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illustrée ci dessous : 

d’excitation 

Dans cette section nous allons créer la source, pour cela nous allons exploiter
assigner l’excitation. On sélectionne  le plan YZ de la barre des outils, 

sur Draw rectangle et choisir trois point arbitraires. 
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exploiter le vide au 
le plan YZ de la barre des outils, 
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Insérer  les informations suivantes
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les informations suivantes : 
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Puisque la source est en place,
utilise lumped port. Ce genre d’excitation est généralement utilisé lorsqu’on s’intéresse au 
champ lointain. 
Sélectionnez la source cliquez Excitation 
        

             Nommer le port source et la

Cliquez sur suivant et sur new line
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t en place, nous allons maintenant attribuer une excitation pour cela on 
lumped port. Ce genre d’excitation est généralement utilisé lorsqu’on s’intéresse au 

iquez Excitation -> Assign> Lumped Port : 

Nommer le port source et laisser les valeurs de l’impédance par défaut

sur suivant et sur new line : 
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attribuer une excitation pour cela on 
lumped port. Ce genre d’excitation est généralement utilisé lorsqu’on s’intéresse au 

 
l’impédance par défaut : 
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En utilisant la souris on positionne le curseur
curseur au dessus du centre, on
Pour visionner le résultat on clique sur 
ceci :  
 

                                                          
                                                                                                                    
   
 IV -2-6.  Attribuer les conditions aux limites 
Dans cette section, une limite de rayonnement est crée afin q
lointain pourront être extraite de la structure.
 Pour obtenir le meilleur résultat
λ/4.De la barre d’outils, Draw Cylinder. 
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la souris on positionne le curseur en dessous du centre on clique
, on clique pour terminer l’opération.  

on clique sur la rubrique excitation dans le project

                                                              
                                                                                                                     

onditions aux limites (Radiation Boundary) 
Dans cette section, une limite de rayonnement est crée afin que les informations du 

xtraite de la structure. 
eur résultat on dessine un cylindre autour du dipôle avec une distance de 

Draw Cylinder.  
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clique puis on place le 

xcitation dans le project Manager on aura 

 

ue les informations du champ 

avec une distance de 
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Avec la géométrie  complète, la radiation peut 
                             
Clique-droit sur  radiation (radiation
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, la radiation peut être attribuée en sélectionnant 

radiation) > Boundary -> Assign -> Radiation : 
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n sélectionnant  toutes les faces. 
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On laisse le nom par défaut rad1 et
On obtient ceci : 

                     
 
IV -2-7.Configuration des solutions
 
Une  solution  devrait être définie pour afficher l
intéressé par la fréquence de résonance de la structure
Analysis -> Add Solution Setup.
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e nom par défaut rad1 et on  clique sur ok 

onfiguration des solutions (Solution Setup) 

définie pour afficher les résultats désirés, on est essentiellement 
ce de résonance de la structure 

> Add Solution Setup. 
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on est essentiellement 
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On insère les données suivante
 

              
 
 
Pour avoir la fréquence de résonance de la structure,
définie. Setup1 -> Add Sweep.
 

  
On insère les données suivantes
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les données suivantes et on clique sur Ok. 

sonance de la structure, une fréquence de balayage doit être 
> Add Sweep. 

données suivantes: 
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une fréquence de balayage doit être 

 

 



Chapitre IV : Simulation des antennes sous HFSS  
 

 

 
 
IV -2-8. Analyse de la structure 

A ce point on devrait être prêt 
fenêtre : 

 

Et on analyse la structure en cliquant sur 
 
IV -2-9.Créer les rapports (Create Reports
 
Après la compilation et l’analyse
de la fréquence de résonance et du  diagramme de rayonnement.
Clique droit sur Results -> Create
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la structure (Structure Analysis) 

prêt pour compiler   si tout est correct on devrait voir

 

la structure en cliquant sur  

Create Reports)  

et l’analyse, on va créer des rapports pour afficher chacun
de la fréquence de résonance et du  diagramme de rayonnement. 

> Create modal solution data Reports. 
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devrait voir cette 

 

chacun des graphes 
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 On clique sur new report  le graphe est affiché ci

Maintenant afficher le graphe de l’impéda
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sur new report  le graphe est affiché ci-dessous : 

Maintenant afficher le graphe de l’impédance en fonction des fréquences  
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On clique sur new report la courbe s’affiche puis cliquez sur add
category : z parameter, quantity
Puis clique une deuxième fois sur add
suit : 

HFSS a l’aptitude de calculer les paramètres
une sphère infinie pour  afficher la représentation du
Clique droit sur l’icône  Radiation 
Setup -> Infinite Sphere. 
 

     
Accepter tout les paramètres par défaut et on clique
Clique droit sur Infinite Sphere1 

Cliquez sur OK 
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sur new report la courbe s’affiche puis cliquez sur add : 
quantity :z(lumpPort1,lumpPort1),function :re. 

une deuxième fois sur add, on aura les deux courbes sur le même graphe comme 

e calculer les paramètres S,Y ,Z automatiquement. Mais on
afficher la représentation du champ lointain. 
Radiation dans project manager et on sélectionne Insert Far Field 

par défaut et on clique sur OK 
nfinite Sphere1 ->Compute Antenna Parameters...              
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n aura les deux courbes sur le même graphe comme 

 
Mais on doit définir 

Insert Far Field 
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Results>create far field report>radiation pattern
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create far field report>radiation pattern 
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On obtient le diagramme de rayonnement
 

   
 
 
 
 
IV -3.Antenne patch triangulaire
Ouvrir un nouveau projet nommé le patch

IV-3-1. Substrat 

Pour dessiner le substrat >Draw Box et entrez
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On obtient le diagramme de rayonnement du dipôle : 

triangulaire  alimentée par une ligne microruban 
Ouvrir un nouveau projet nommé le patch.  

Draw Box et entrez les variables suivantes : 
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   IV -3-2. Dessiner la ligne d’alimentation

  Pour dessiner il suffit de cliquer s

IV-3-3. Dessiner Patch (élément
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la ligne d’alimentation 

Pour dessiner il suffit de cliquer sur  et entrez les valeurs suivantes : 

élément rayonnant): dessiner  et  suivez les étapes suivantes:
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et  suivez les étapes suivantes: 
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On sait que le patch et la ligne d’alimentation doivent être un seul objet, donc on a besoin de 
les unirent cliquez sur les deux objets  Patch and Feed_line, clique droit Edit > Boolean > 
Unite.  
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IV -3-4. Plan de masse (Ground Plane

Pour dessiner le plan de masse cliquez sur 
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Ground Plane) 

dessiner le plan de masse cliquez sur  et remplir la table des propriétés
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propriétés :    
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IV -3-5 .Attribuer une excitation 
 

                                     

 

                    

On clique  sur  ‘suivant’ et choisir  new line 
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 Le port d’excitation est illustré sur cette figure : 

 

IV -3-6.  Assigner les conditions aux limites 
Maintenant que le model est crée, on a besoin d’attribuer les conditions aux limites. Dans 
HFSS, les radiations aux limites sont utilisées pour simuler les problèmes que trouvent les 
ondes pour se propager infiniment loin dans l’espace. HFSS s’imprègne de l’onde jusqu'à la 
limite. Dans notre cas  notre ABC (Absorbing Boundary condition) est un air box. 
Pour dessiner l’Air Box cliquez sur Draw>Box  
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 Boundary, clique droit > Assign Boundary > radiation

        

Voilà ce qu’on obtiendra comme résultat:
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> Assign Boundary > radiation 

ce qu’on obtiendra comme résultat: 
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IV-3-7 .Configuration d’analyse ( Analysis Setup) 
Maintenant notre model est prêt a être exécuté. Pour identifier notre analyse on doit créer ce 
qu’on appelle solution setup pour cela : 

HFSS > Analysis Setup > Add Solution Setup clique general tab, Solution frequency: 7.5 
GHz, Maximum Number of Passes: 20 and Maximum Delta S per pass: 0.02.  
 
IV-3-8. Ajouter une fréquence de balayage  (Frequency Sweep): 
Pour ajouter une fréquence de balayage : HFSS > Analysis Setup > Add Sweep .Solution 
Setup: Setup1.cliquez OK. Sweep Type: Fast, Frequency Setup Type: Linear Count, Start: 5 
GHz, Stop: 10 GHz, Count: 500. Clique sur OK.  
 
IV-3-9 .Validation  
HFSS > Validation Check.  

 

IV-3-10 Analyser tout  
HFSS > Analyze pour analyser s’il ya des erreurs elles seront affichées en bas de la fenêtre.  
IV-3-11. Les données de la solution (Solution Data) 
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IV-3-12. Créer les rapports 
Results > Create Modal solution Data 
Traces Window: Setup1: Adaptive1. Category:
lumpPort), Function dB puis clique 

 

 

 
L’antenne résonne au alentour de 7.5GHz.
entre 7.00 GHz et 8.00 GHz (changer
réexécuter). 
 

Simulation des antennes sous HFSS  

94 

 
Modal solution Data Report: 

Traces Window: Setup1: Adaptive1. Category: S Parameter, Quantity: S (lumpPort, 
clique sur new report. 

L’antenne résonne au alentour de 7.5GHz. Pour un résultat précis on peu zoomer sur le graphe 
(changer le début et la fin a 7GHz et 8GHz respectivement p
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lumpPort, 

 

 

on peu zoomer sur le graphe 
le début et la fin a 7GHz et 8GHz respectivement puis 
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 Radiation Pattern (diagramme de rayonnement) 
Créer une  sphère infinie. Puis aller à Results< Create far field Report >3D Polar Plot. Clique  
new report. 
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Pour un diagramme de rayonnement en 2D on clique sur  Results< Create far field Report 
>Radiation Pattern. 

 

 
 
 
IV-4.Antenne patch alimentée pa
Ouvrir un nouveau projet et nommer le probe_feed_patch_antenna
HFSS > Solution Type Driven Terminal
Choisir l’unité  
 3D Modeler > Units>cm puis OK.
  

                             

Attributer d’abord le materiel 
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Pour un diagramme de rayonnement en 2D on clique sur  Results< Create far field Report 

Antenne patch alimentée par un câble coaxial  
Ouvrir un nouveau projet et nommer le probe_feed_patch_antenna : 

Driven Terminal 

3D Modeler > Units>cm puis OK. 
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Pour un diagramme de rayonnement en 2D on clique sur  Results< Create far field Report 
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Dans le champ recherche on tape
 
IV-4-1.Créer le substrat  

Draw>Box ou clique sur 
En utilisant les champs de saisie de
X: -5.0 Y: -4.5, Z: 0.0, appuyez sur la touche Entrée
À l'aide des champs de saisie de
Dx : 10.0, dy: 9.0, dZ: 0,32, appuyez sur la touche Entrée
Ouvrez la fenêtre des  Properties 
Cliquez View>Fit All>Active View,
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recherche on tape Rogers RT/ duroid 5880 (tm), clique OK.

 
En utilisant les champs de saisie des coordonnées, entrez la position de la boîte

0.0, appuyez sur la touche Entrée. 
À l'aide des champs de saisie des coordonnées, entrez le coin opposé de la boîte

10.0, dy: 9.0, dZ: 0,32, appuyez sur la touche Entrée. 
Properties tapez: Sub1 

View>Fit All>Active View, ou cliquez CTRL+D.Le substrat ressemblera à ce
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. 

coordonnées, entrez la position de la boîte. 

de la boîte. 

Le substrat ressemblera à ceci : 
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IV-4-2.Créer le  plan de masse infini 
Draw>Rectangle 
En utilisant les champs de saisie des coordonnées, entrez la position du rectangle. 
X: -5.0, Y: -4.5, Z: 0.0, appuyez sur la touche Entrée. 
En utilisant les champs de saisie des coordonnées, entrez le coin opposé du rectangle: 
Dx : 10.0, dy: 9.0, dZ: 0.0, appuyez sur la touche Entrée 
Nommé le : Inf_GND .La figure ci-dessous montre le résultat : 

 
 
IV-4-3.Attribuer une frontière perfect E au plan de masse infini 
Edit>Select>By Name On selectionne: Inf_GND 

                                                   

HFSS>Boundaries>Assign>Perfect E 
La fenêtre s’ouvre, entrez le nom suivant : PerfE_Inf_GND 
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La radiation est illustrée ci-dessous
                  

IV-4-4.Créer le plan de masse infini 
Draw>Circle 
En utilisant les champs de saisie de
X: -0.5, Y: 0,0, Z: 0.0, appuyez sur la touche Entrée
En utilisant les champs de saisie de
Dx : 0.16, dy: 0.0, dZ: 0.0, appuyez sur la touche Entrée
Définir le nom: Cut_Out 
Sélectionnez les deux  objects Inf_GND et
Modeler>Boolean>Subtract: 
Blank Parts: Inf_GnD 
Tool Parts: Cut_Out 
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dessous : 

Créer le plan de masse infini Cut Out 

En utilisant les champs de saisie des coordonnées, entrez la position centrale
0.5, Y: 0,0, Z: 0.0, appuyez sur la touche Entrée 

En utilisant les champs de saisie des coordonnées, entrez le rayon: 
0.16, dy: 0.0, dZ: 0.0, appuyez sur la touche Entrée 

les deux  objects Inf_GND et Cut_Out: 
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coordonnées, entrez la position centrale 
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IV-4-5.Créer le Patch 
Draw>Rectangle 
En utilisant les champs de saisie des coordonnées, entrez la position du rectangle 
X: -2.0, Y: -1,5 Z: 0,32, appuyez sur la touche Entrée 
En utilisant les champs de saisie des coordonnées, entrez le coin opposé du rectangle: 
Dx : 4.0, dy: 3.0, dZ: 0.0, appuyez sur la touche Entrée 
La fenêtre des propriétés s’ouvre automatiquement entrez le nom: Patch 
 

 

 
 
IV-4-6.Attribuer un champ perfect E pour le patch 
Sélectionnez le patch allez vers HFSS>Boundaries>Assign>Perfect E 
Nommé: PerfE_Patch cliquez sur OK. 
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IV-4-7.Créer le câble coaxial 
Choisir: vacuum(Aluminium) 

                                              

Pour le dessin du coaxial: 
Draw>Cylinder 
En utilisant les champs de saisie des coordonnées, entrez la position du cylindre 
X: -0.5, Y: 0.0, Z: 0.0 Appuyez sur la touche Entrée 
À l'aide des champs de saisie des coordonnées, entrez le rayon: 
dX: 0.16, dY: 0.0, dZ: 0.0 Appuyez sur la touche Entrée  
Utiliser les champs de saisie des coordonnées, entrez la hauteur: 
dX: 0.0, dY: 0.0, dZ: -0.5 Appuyez sur la touche Entrée  
Nommé : Coax cliquez sur Ok 
 

 

 
Attribuer un materiel: 
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- Taper PEC (perfect electric conductor) 

                                                
 IV-4-8.Créer l’âme du coaxial 
 
Draw>Cylinder 
En utilisant les champs de saisie des coordonnées, entrez la position du cylindre 
X: -0.5, Y: 0,0, Z: 0.0 Appuyez sur la touche Entrée 
À l'aide des champs de saisie des coordonnées, entrez le rayon: 
DX 0.07, dy: 0.0, dZ: 0.0 Appuyez sur la touche Entrée 
4 Utiliser les champs de saisie des coordonnées, entrez la hauteur: 
DX 0.0, dy: 0.0, dZ: -0.5 Appuyez sur la touche Entrée 
Nommé: Coax_Pin. 
 
. 
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IV-4-9.Créer le port d'onde (wave port)
Pour créer un cercle qui représente le port:
Cliquez sur Draw> Cercle 
En utilisant les champs de saisie de
X: -0.5, Y: 0,0, Z: -0.5 Appuyez sur la touche Entrée
À l'aide des champs de saisie de
DX 0.16, dy: 0.0, dZ: 0.0: Appuyez sur la touche Entrée
Dans la fenêtre Propriétés nom: Port1
Cliquez sur le bouton OK  
Sélectionnez: Port1 
                                                
IV-4-10.Attribuer une excitation au port d’onde
 
 HFSS>Excitations>Assign>Wave Port
Spécifié le nom: p1 
Le terminal est p1 dans l'arborescence du projet

                 
 

L’excitation est illustrée ci dessous:
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(wave port)  
un cercle qui représente le port: 

En utilisant les champs de saisie des coordonnées, entrez la position centrale
0.5 Appuyez sur la touche Entrée 

À l'aide des champs de saisie des coordonnées, entrez le rayon du cercle 
DX 0.16, dy: 0.0, dZ: 0.0: Appuyez sur la touche Entrée 

om: Port1 

 
une excitation au port d’onde  

citations>Assign>Wave Port 

Le terminal est p1 dans l'arborescence du projet. 

 

xcitation est illustrée ci dessous: 
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coordonnées, entrez la position centrale 
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IV-4-11.Création de la sonde (probe): 
Cliquez sur Draw> Cylinder 
En utilisant les champs de saisie des coordonnées, entrez la position du cylindre 
X: -0.5, Y: 0,0, Z: 0.0 Appuyez sur la touche Entrée 
À l'aide des champs de saisie de coordonnées, entrez le rayon: 
Dx : 0.07, dy: 0.0, dZ: 0.0 Appuyez sur la touche Entrée 
Utiliser les champs de saisie des coordonnées, entrez la hauteur: 
DX 0.0, dy: 0.0, dZ: 0,32 Appuyez sur la touche Entrée 
Définir le nom: Probe 
  

                        
 

Pour définir le matériau par défaut: Utilisez de la barre d'outils Modeler Matériaux 3D. 
Choisir vaccum.                                               

IV-4-12.Créer l’Air 
Cliquez sur Draw>Box 
En utilisant les champs de saisie des coordonnées, entrez la position de la boîte 
X: -5.0, Y: -4.5, Z: 0.0, appuyez sur la touche Entrée 
 À l'aide des champs de saisie des coordonnées, entrez le coin opposé de la boîte 
DX 10.0, dy: 9.0, dZ: 3.32. 
Définir le nom: Air 
Pour s'adapter à la vue: Cliquez sur View>Fit All>Active View   
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IV-4-13.Assigner les conditions aux limites (Radiation Boundary)  
Sélectionnez les faces : 
Cliquez sur Edit>Select>Faces 
Sélectionner graphiquement toutes les faces de l'objet, sauf la face à Z = 0.0cm (le fond). 
Pour créer une limite de rayonnement HFSS>Boundaries>Assign>Radiation 
La boîte de dialogue des limites des rayonnements s'ouvre, nommé: Rad1 
 
La radiation est illustrée ci dessous: 

 

IV-4-14.Créer une configuration du rayonnement (radiation setup)  
Pour définir la configuration de rayonnement 
HFSS>Radiation>Insert Far Field Setup>Infinite  
La boîte de dialogue Far Field Radiation Sphere Setup  s'ouvre. 
Sélectionnez l'onglet sphère infinie : 
Nom: ff_2d 
Phi: (Début: 0, Arrêt: 90, Step Taille: 90) 
Theta: (Début: -180, Arrêt: 180, Step Taille: 2) 
Cliquez sur OK. 
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IV-4-15.Configuration de l'analyse (Analysis Setup) 
Création d'une configuration d'analyse HFSS>Analysis Setup>Add Solution Setup 
Dans l'onglet Général: 
Solution fréquence: 2,25 GHz 
Nombre maximum de passes: 20 
Delta maximale: 0.02 
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IV-4-16.Ajout d'une fréquence de balayage (Frequency Sweep) 
HFSS>Analysis Setup>Add Sweep 
Add/Edit Sweep. 
Indiquez les éléments suivants: 
Sweep Type: Fast (Type de balayage: Rapide) 
Frequency Setup Type: Linear Count 
Start: 1.0GHz 
Stop: 3.5GHz 
Count: 201 
                                        
IV-4-17.Analyse 
Validation du modèle>HFSS>Validation Check 
Cliquez sur HFSS>Analyze All 
Pour afficher les données de la solution: 
Cliquez HFSS>Results>Solution Data la boîte de dialogue de données solution s'ouvre. 
 
IV-4-18.Création des rapports  
HFSS>Results>Create Terminal Solution Data Report. 
Solution: Setup1: Balayage1 
Domaine: Sweep 
Catégorie: Terminal S Paramètre 
Quantité: St (Port1_T1, Port1_T1), 
Fonction: dB 
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 Cliquez sur  New Report  

IV-4-19.Créer  un rapport de 
HFSS>Results>Create Far Fields Report>Radiation
Solution: Setup1: sweep1 
Géométrie: ff_2d 
Dans l'onglet Trace: 
Sélectionnez Theta le balayage primaire.
Catégorie: Gain 
Quantité: GainTotal 
Fonction: dB 
Cliquez sur New repport. 
Le diagramme de rayonnement en 2D s’affiche:
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rapport de Champ lointain 
HFSS>Results>Create Far Fields Report>Radiation Pattern. 

Sélectionnez Theta le balayage primaire. 

yonnement en 2D s’affiche: 
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Pour l’affichage en 3D 
HFSS>Results>Create Far Fields Report>3D polar plot
Cliquez sur New repport: 
 

 
IV-5. Antenne Microruban T
Simuler et analyser une Antenne complexe comme 
équilatéral avec une paire de fentes étroites en utilisant 
principal est de montrer comment créer
 

 
Cette figure  représente la géométrie de l’antenne triangulaire équilatéral double avec
une paire de fentes étroites. 
 
IV-5-1.Débuté le projet  
A présent, vous pouvez lancer HFSS, l'ouverture d'un projet et nommez
"Triangular_Antenna". 
Ensuite, réglez le type de solution:
- Sélectionner le menu HFSS >Solution Type
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HFSS>Results>Create Far Fields Report>3D polar plot. 

icroruban T riangulaire  
imuler et analyser une Antenne complexe comme l’antenne bi fréquences

équilatéral avec une paire de fentes étroites en utilisant l’Ansoft HFSS. Notre 
al est de montrer comment créer le dessin compliqué. 

éométrie de l’antenne triangulaire équilatéral double avec

A présent, vous pouvez lancer HFSS, l'ouverture d'un projet et nommez-le 

Ensuite, réglez le type de solution: 
Sélectionner le menu HFSS >Solution Type 

Simulation des antennes sous HFSS  2013 

 

 

s triangulaire 
Notre objectif 

 

éométrie de l’antenne triangulaire équilatéral double avec 
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Choisissez Driven Terminal 
Cliquez sur le bouton Ok 
Pour définir les unités 
Sélectionner l'élément de menu 3D modeler > Units
Sélectionnez  l’unité: mm 
Cliquez sur le bouton OK 
 
IV-5-2.Créer le substrat 

Pour dessiner le substrat, cliquez sur  

 

 
IV-5-3. Dessiner le Patch triangulaire

Dessiner le patch, cliquez sur   de 
remplissant  les données ci-dessous
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Sélectionner l'élément de menu 3D modeler > Units 

Pour dessiner le substrat, cliquez sur    de la barre d'outils. Puis remplissez la 

Patch triangulaire 

le patch, cliquez sur   de  la barre d'outils. Ensuite, dessinez un rectangle en 
dessous : 
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remplissez la table :  

 

 

la barre d'outils. Ensuite, dessinez un rectangle en 
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Nous commençons à tracer une ligne poly pour former un

en cliquant sur cette icône 

Puis commencer à saisir les positions des points (P1, P2 et P3).
Ensuite, sélectionnez le Patch & Polyline1, clique droit, sélectionnez 
Substract 
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Nous commençons à tracer une ligne poly pour former un triangle, comme indiqué ci

 sur la barre d'outils. 

Puis commencer à saisir les positions des points (P1, P2 et P3). 
Ensuite, sélectionnez le Patch & Polyline1, clique droit, sélectionnez Edit > Boolean > 
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e indiqué ci-dessous 

 

Edit > Boolean > 
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Maintenant, nous commençons un second 

Entrez ensuite les positions des points appropriés 
de sélectionner le Patch & Poly

Attribuer une frontière perfect E pour le patch. Sélectionnez Patch, clique droit 
Boundary > Perfect E… 
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us commençons un second  Poly ligne 

sitions des points appropriés à la poly ligne 2, lorsque vous aurez terminé 
de sélectionner le Patch & Poly line2, clique droit, sélectionnez Edit > Boolean > Substract

rfect E pour le patch. Sélectionnez Patch, clique droit 
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2, lorsque vous aurez terminé 
Edit > Boolean > Substract 

 
rfect E pour le patch. Sélectionnez Patch, clique droit  
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IV-5-4.Plan de masse  

Pour dessiner le plan de masse, cliquez sur 

 

 
 
Puis assignez une frontière perfect E pour le patch. Sélectionnez le plan de
sélectionnez assign>Boundary> Perfect E 

Simulation des antennes sous HFSS  

113 

Pour dessiner le plan de masse, cliquez sur  de la barre d'outils.  

Puis assignez une frontière perfect E pour le patch. Sélectionnez le plan de 
sélectionnez assign>Boundary> Perfect E ... 
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 masse, clique droit 
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IV-5-5.Créer le câble coaxial
 
L'antenne est excitée à l'aide d'un câble coaxial. Ce port est situé sous le patch.
Pour dessiner le câble coaxial, nous commençons par dessiner le plan de masse infini Cut_Ou
comme indiqué ci-dessous : 

Ensuite, sélectionnez le plan de masse  et Cut_Out, clique droit, sélectionnez Edit > Boolean 
> Substract 
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câble coaxial  

L'antenne est excitée à l'aide d'un câble coaxial. Ce port est situé sous le patch.
Pour dessiner le câble coaxial, nous commençons par dessiner le plan de masse infini Cut_Ou

Ensuite, sélectionnez le plan de masse  et Cut_Out, clique droit, sélectionnez Edit > Boolean 
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L'antenne est excitée à l'aide d'un câble coaxial. Ce port est situé sous le patch. 
Pour dessiner le câble coaxial, nous commençons par dessiner le plan de masse infini Cut_Out 

 

 
Ensuite, sélectionnez le plan de masse  et Cut_Out, clique droit, sélectionnez Edit > Boolean 
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Créer le câble coaxial  
Pour créer le câble coaxial, sélectionnez l'élément  de menu Draw> Cylinder,
données décrites ci-dessous : 
 

 

 
 IV-5-6.Créer l’âme centrale du coaxial
Sélectionnez l'élément de menu Draw> Cylinder, puis 
dessous : 
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créer le câble coaxial, sélectionnez l'élément  de menu Draw> Cylinder,
 

Créer l’âme centrale du coaxial 
électionnez l'élément de menu Draw> Cylinder, puis entrez les données comme décrites 
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créer le câble coaxial, sélectionnez l'élément  de menu Draw> Cylinder,  puis entrez les 

 

 

entrez les données comme décrites ci-
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IV-5-7.Créer le port d'onde  
Pour créer un cercle qui représente le port:
Sélectionnez le menu Draw > Circle, puis entrez les données comme indiqué ci
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Pour créer un cercle qui représente le port: 
Sélectionnez le menu Draw > Circle, puis entrez les données comme indiqué ci
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Sélectionnez le menu Draw > Circle, puis entrez les données comme indiqué ci-dessous : 
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Pour attribuer une excitation au port d'onde, sélectionnez Port 1, puis allez à Menu 
HFSS >Excitations > Assign > Wave port
 

 
IV-5-8. Créer la sonde 
Pour créer la sonde, sélectionnez l'élément de menu Draw> Cylinder, puis entrez les données 
Ci-dessous : 
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Pour attribuer une excitation au port d'onde, sélectionnez Port 1, puis allez à Menu 
HFSS >Excitations > Assign > Wave port 

la sonde, sélectionnez l'élément de menu Draw> Cylinder, puis entrez les données 
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Pour attribuer une excitation au port d'onde, sélectionnez Port 1, puis allez à Menu  

 

la sonde, sélectionnez l'élément de menu Draw> Cylinder, puis entrez les données  
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IV-5-9.Assigner les conditions aux limites

Pour dessiner la boîte à air, cliquez sur 

 
 

Simulation des antennes sous HFSS  

118 

les conditions aux limites   

Pour dessiner la boîte à air, cliquez sur  la barre d'outils.  
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Maintenant, sélectionnez  Box1, clique d
 L'antenne finale devrait ressembler à ce

 
IV-5-10. Configuration de l'Ana
Enfin, nous avons notre modèle prêt 
configuration d'analyse, HFSS > Analysis Setup
Dans la fenêtre de configuration de
Frequency: 1, 8 GHz, Maximum Number of 
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Maintenant, sélectionnez  Box1, clique droit > Assign Boundary > radiation
ressembler à ceci : 

Configuration de l'Analyse  
modèle prêt à fonctionner. Maintenant, nous allons 
HFSS > Analysis Setup > Add Solution Setup. 

Dans la fenêtre de configuration des solutions, cliquez sur l'onglet général, Solution
Maximum Number of Passes: 20 and Maximum Delta 
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> Assign Boundary > radiation 

 

nous allons effectuer une 

énéral, Solution 
20 and Maximum Delta S: 0.02 
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IV-5-11.Ajout d’un balayage
Pour ajouter un balayage de fréquences, HFSS > Analysis Setup > Add Sweep.
Sélectionnez Configuration de la solution: Setup1. Cliquez sur le bouton OK.
Sweep Type: fast, Frequency Setup Type: Linear C
Count: 200. 
 
IV-5-12.Validation du modèle
Pour valider le modèle, sélectionnez le HFSS de menu> Validation Check. Cliquez sur le 
IV-5-13.Analyser tout  
Pour démarrer le processus, sélectionnez le menu HFSS> Analyse.

Ou cliquez sur l’icône . 
IV-5-14.Les données de la solution
 

 
IV-5-15. Créer les rapports 
Results > Create modal solution 
Dans la fenêtre, régler la  solution pour Setup1: Adaptive1. Dans l'onglet Y
Quantité : S (waveport, waveport), fonction
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balayage de fréquences 
ge de fréquences, HFSS > Analysis Setup > Add Sweep.

Sélectionnez Configuration de la solution: Setup1. Cliquez sur le bouton OK.
Sweep Type: fast, Frequency Setup Type: Linear Count, Start: 1 GHz, Stop: 3 GHz

alidation du modèle  
r valider le modèle, sélectionnez le HFSS de menu> Validation Check. Cliquez sur le 

Pour démarrer le processus, sélectionnez le menu HFSS> Analyse. 

Les données de la solution  

 
Results > Create modal solution data Report>rectangular plot 

solution pour Setup1: Adaptive1. Dans l'onglet Y
(waveport, waveport), fonction : dB, puis cliquez sur new report.
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ge de fréquences, HFSS > Analysis Setup > Add Sweep. 
Sélectionnez Configuration de la solution: Setup1. Cliquez sur le bouton OK. 

ount, Start: 1 GHz, Stop: 3 GHz 

r valider le modèle, sélectionnez le HFSS de menu> Validation Check. Cliquez sur le  

 

solution pour Setup1: Adaptive1. Dans l'onglet Y : S Parameter, 
: dB, puis cliquez sur new report. 

 



Chapitre IV : Simulation des antennes sous HFSS  
 

 

IV-6.Antenne RDA(Resonant dielectric antenna)
 
IV-6 -1.Créer le nouveau projet
La première étape dans l'utilisation HFSS pour résoudre un problème, consiste à créer un 
projet  dans lequel les données associées au problème peuvent être sauvegardé
lorsque vous exécutez HFSS 11,un nouveau projet nommé project
conception nommée HFSSDesignn.
Insérez une conception HFSS
Pour insérer une conception HFSS dans le projet, effectuez l'une des actions suivantes:
• Cliquez sur Project > Insert HFSS Design.
• Cliquez-droit sur le nom du projet dans la fenêtre du gestionnaire de projet, et
puis cliquez sur Insert >Insert HFSS Design.
IV-6 -2.Création du modèle 
Cette section vous montre comment créer la géométrie de l'antenne. 
La géométrie de ce modèle d'ant

                 

IV-6 -3.Sélectionner le type de solution
Avant de dessiner le modèle d'antenne, vous devez 
Lorsque vous configurez votre modèle, les options disponible
solution de conception. 
Pour spécifier le type de la solution:
-Cliquez sur HFSS>Solution Type.
Séléctionnez  Driven modal. 

Réglages des unités 
Maintenant, spécifier l’unité du dessin pour votre modèle. Pour ce problème d'antenn
définir les unités du dessin pour millimètres.
*La géométrie de cette antenne 
élémentaires ci-dessous avec leurs dimensions:
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(Resonant dielectric antenna) 

1.Créer le nouveau projet 
La première étape dans l'utilisation HFSS pour résoudre un problème, consiste à créer un 
projet  dans lequel les données associées au problème peuvent être sauvegardé

vous exécutez HFSS 11,un nouveau projet nommé project n est crée 
conception nommée HFSSDesignn. 
nsérez une conception HFSS 

Pour insérer une conception HFSS dans le projet, effectuez l'une des actions suivantes:
ert HFSS Design. 

le nom du projet dans la fenêtre du gestionnaire de projet, et
Insert >Insert HFSS Design. 

 
Cette section vous montre comment créer la géométrie de l'antenne.  
La géométrie de ce modèle d'antenne est indiquée sur la figure ci-dessous: 

le type de solution 
Avant de dessiner le modèle d'antenne, vous devez d'abord spécifier le Type de la
Lorsque vous configurez votre modèle, les options disponibles dépendent du  type de

solution: 
HFSS>Solution Type. 

Maintenant, spécifier l’unité du dessin pour votre modèle. Pour ce problème d'antenn
dessin pour millimètres. 

La géométrie de cette antenne à résonateur diélectrique (DRA) consiste des cinq objets 
dessous avec leurs dimensions: 
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La première étape dans l'utilisation HFSS pour résoudre un problème, consiste à créer un 
projet  dans lequel les données associées au problème peuvent être sauvegardées. Par défaut, 

crée et il insère une 

Pour insérer une conception HFSS dans le projet, effectuez l'une des actions suivantes: 

le nom du projet dans la fenêtre du gestionnaire de projet, et 

 

 

d'abord spécifier le Type de la solution. 
dépendent du  type de la  

Maintenant, spécifier l’unité du dessin pour votre modèle. Pour ce problème d'antenne, 

résonateur diélectrique (DRA) consiste des cinq objets 
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Air volume de 30 mm d'air et une hauteur de 35 mm
Spherical Cavity  est de 25 mm de rayon
Spherical DRA 12,5 mm de rayon
Annular ring 5,8 mm de rayon extérieur et d'une largeur de 1,0 mm.
Feed gap 1mm d'épaisseur. 
IV-6 -4.Dessiner la cavité 
Le premier objet que vous allez en tirer est la cavité de l'antenne, qui est constit
une sphère, puis la diviser en un solide hémisphérique.
IV-6 -5.Dessiner la Sphère 

Cliquez sur Draw>Sphere, ou cliquez sur le bouton sphère 
Sélectionnez le point central de la sphère en entrant les valeurs suivantes dans les
coordonnées: X coordinate 0, Y
Appuyez sur la touche de tabulation pour 
La barre d'état vous invite maintenant à entrer un rayon de la sphère.
Appuyez sur Entrée pour accepter le point central.
Tab dans la zone X et entrez 25.
Appuyez sur Entrée pour accepter la valeur du rayon.
La fenêtre Propriétés apparaît. Cliquez sur OK.
La sphère apparaît dans la zone de dessin.
Appuyez sur Ctrl + D pour s'adapter à la sphère 

Renommez la sphère : Cavity 

Diviser la cavité 
Diviser la cavité en un solide hémisphérique.Pour cela
Sélectionnez la cavité, Cliquez Modeler> Boolean> Split.
La boîte de dialogue de Spilt apparaît.
Sélectionner XY  split plane qu
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de 30 mm d'air et une hauteur de 35 mm 
st de 25 mm de rayon 

12,5 mm de rayon 
5,8 mm de rayon extérieur et d'une largeur de 1,0 mm. 

Le premier objet que vous allez en tirer est la cavité de l'antenne, qui est constit
une sphère, puis la diviser en un solide hémisphérique. 

, ou cliquez sur le bouton sphère  de la barre d'outils.
Sélectionnez le point central de la sphère en entrant les valeurs suivantes dans les

0, Y coordinate 0, Z coordinate 0 
Appuyez sur la touche de tabulation pour  passer à la zone de texte de coordonnées suivante.
La barre d'état vous invite maintenant à entrer un rayon de la sphère. 

our accepter le point central. 
Tab dans la zone X et entrez 25. 
Appuyez sur Entrée pour accepter la valeur du rayon. 
La fenêtre Propriétés apparaît. Cliquez sur OK. 
La sphère apparaît dans la zone de dessin. 
Appuyez sur Ctrl + D pour s'adapter à la sphère dans la région dessin. 

 

iviser la cavité en un solide hémisphérique.Pour cela : 
Sélectionnez la cavité, Cliquez Modeler> Boolean> Split. 
La boîte de dialogue de Spilt apparaît. 

qui sera utilisé pour diviser la cavité . 

Simulation des antennes sous HFSS  2013 

 

Le premier objet que vous allez en tirer est la cavité de l'antenne, qui est constitué  par 

de la barre d'outils. 
Sélectionnez le point central de la sphère en entrant les valeurs suivantes dans les boîtes des 

passer à la zone de texte de coordonnées suivante. 

 



Chapitre IV : Simulation des antennes sous HFSS  2013 
 

 

123 

 

Sélectionnez Negative side. La cavité est subdivisée en un solide hémisphérique, comme 
indiqué  ci-dessous: 

 
Attribuer une couleur red (RGB settings 255, 0, 0) et une trensparence 0.07. 
     

 
 
IV -6-6.Dessiner le DRA 
Maintenant, dessinez le résonateur diélectrique  (DRA). 
Draw> Sphere. 
Sélectionnez le point de centre (0, 0, 0) de la sphère en saisissant les valeurs dans 
X, Y, Z et des boîtes de coordonnées. 
Appuyez sur Entrée pour accepter le point central. 
Tab dans la boîte DX et entrer 12.5 que le rayon de la sphère. 
Appuyez sur Entrée pour accepter la valeur du rayon. 
La sphère apparaît dans la zone de dessin. 
La sphère doit apparaître comme indiqué ci-dessous: 
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Renommer la sphére :DRA 
créer un nouveau matériau et l'assigner à DRA 
-Sélectionnez dRA, sous l'onglet Attribute de la fenêtre PropriétésMM 

 
Cliquez sur  Add Material. 
 La boîte de dialogue matériau apparaît: 
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-Tapez dra_diel dans la zone de texte name material pour nommer le nouveau matériel. 
- Dans la ligne de la permittivité relative, tapez 9,5 , puis appuyez sur Entrée pour accepter la 
valeur. 
Cliquez sur OK. 
Le dra_diel matériel apparaît maintenant dans le navigateur de matériel. 
Le nouveau dra_diel matériel est maintenant assigné au DRA . 
L'objet DRA doit apparaître dans votre modèle d'antenne ci-dessous: 
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IV-6 -7.Créer l’anneau d’alimentation
Dans ce modèle d'antenne, l’anneau d'alimentation est contrôlé par l'ouverture
le-champ E va rayonner.  
Dessinez Circle1 

Cliquez sur Draw> Circle, ou cliquez sur le bouton cercle Dessin 
Sélectionnez le point de centre (0, 0, 0) du cercle en tapant les valeurs dans les boîtes de
coordonnées  
Appuyez sur Entrée. 
Tab dans la zone X et entrez 4.8 comme rayon.
Appuyez sur Entrée pour accepter la valeur.
La fenêtre Propriétés apparaît.
Circle1 apparaît maintenant dans le modèle.
Dessinez Circle2 

Cliquez sur Draw> Circle, ou cliquez sur le bouton cercle Dessin 
Sélectionnez le point de centre (0, 0, 0) du
coordonnées  
Tab dans la boîte DX et entrez 5.8 comme rayon.
Appuyez sur Entrée pour accepter la valeur du rayon.
Circle1 et Circle2 devrait maintenant apparaître à la fois dans le modèle, comme le montre
ci-dessous: 

                         
Ensuite, soustraire Circle1 de Circle2, ce qui se traduira par l’anneau d'alimentation  de 1 mm 
de large. 
Sélectionnez Circle2 en cliquant sur son nom dans l'arborescence .
Circle1 et Circle2 devraient être sélectionné
Cliquez Modeler>Boolean>Subtract 
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l’anneau d’alimentation 
Dans ce modèle d'antenne, l’anneau d'alimentation est contrôlé par l'ouverture

ircle, ou cliquez sur le bouton cercle Dessin de la barre d'outils.
Sélectionnez le point de centre (0, 0, 0) du cercle en tapant les valeurs dans les boîtes de

Tab dans la zone X et entrez 4.8 comme rayon. 
trée pour accepter la valeur. 

La fenêtre Propriétés apparaît. 
Circle1 apparaît maintenant dans le modèle. 

Cliquez sur Draw> Circle, ou cliquez sur le bouton cercle Dessin  de la barre d'outils.
Sélectionnez le point de centre (0, 0, 0) du cercle en tapant les valeurs dans

Tab dans la boîte DX et entrez 5.8 comme rayon. 
Appuyez sur Entrée pour accepter la valeur du rayon. 
Circle1 et Circle2 devrait maintenant apparaître à la fois dans le modèle, comme le montre

 
Ensuite, soustraire Circle1 de Circle2, ce qui se traduira par l’anneau d'alimentation  de 1 mm 

Sélectionnez Circle2 en cliquant sur son nom dans l'arborescence . 
Circle1 et Circle2 devraient être sélectionné à la fois.  

Modeler>Boolean>Subtract Soustraire ou cliquez sur Subtract  
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Dans ce modèle d'antenne, l’anneau d'alimentation est contrôlé par l'ouverture à travers lequel 

de la barre d'outils. 
Sélectionnez le point de centre (0, 0, 0) du cercle en tapant les valeurs dans les boîtes deS 

de la barre d'outils. 
cercle en tapant les valeurs dans les boîtes des 

Circle1 et Circle2 devrait maintenant apparaître à la fois dans le modèle, comme le montre 

Ensuite, soustraire Circle1 de Circle2, ce qui se traduira par l’anneau d'alimentation  de 1 mm 
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Cliquez sur OK pour effectuer la soustraction. 
 
Cercle1 est soustraite de Circle2, résultant en une largeur de 1 mm, comme illustré ci-dessous:

 
Nommer l’anneau annular_ring 
 
Modifier les attributs de l' anneau de l'alimentation 
Clique droit sur annular ring modifier la couleur  
Blue(RGB 0.0.128) trensparence :0.09 
Il doit apparaitre comme illustré ci-dessous : 
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IV-6 -8.Dessiner le gap d’alimentation  
Cliquez sur Draw> Rectangle,  
Tab dans les boîtes de coordonnées et entrez les valeurs suivantes pour spécifier l'origine du 
rectangle: 
X coordonner -0.5 
Coordonnée Y 0 
Coordonnée Z 0 
Appuyez sur Entrée pour accepter les valeurs.puis entrez les valeurs suivantes à spécifier le 
point de fin: 
dX coordonnées 1 
dY coordonnées 10 
dZ coordonnée 0 
Appuyez sur Entrée pour accepter les valeurs. 
Le rectangle apparaît dans le modèle comme indiqué ci-dessous: 
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IV-6 -9.Croiser le rectangle et l'anneau de l'alimentation  
Croiser le rectangle et l’anneau d'alimentation pour produire la fente d'alimentation 
Cliquez sur Tools > Options > Modeler Options. 
La boîte de dialogue Options de 3D Modeler s'affiche. 
Les objets Retangle1 et annular_rng devraient maintenant être à la fois sélectionnés. 
Cliquez Modeler > Boolean > Intersect,, ou cliquez sur le bouton Intersect, 
à partir de la barre d'outils, pour effectuer l'intersection. 
À la suite de l'intersection, la fente d'alimentation est produite sans la suppression de la fente 
annulaire, il est destiné à alimenter, comme indiqué ci-dessous: 

                 
Nommé le rectangle :gap 
Clique droit modifier la couleur green (RGB settings 0, 255, 0) 
Transparence : 0 
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IV -6-10.Dessiner le volume Air 
Pour analyser les effets des rayonnements, vous devez créer un objet virtuel qui représente 
la limite de rayonnement. Pour ce modèle d'antenne, vous allez créer un volume d'air 
suffisamment loin du modèle. 
Ensuite, vous allez dessiner un polyèdre régulier avec 18 segments pour représenter cet objet 
virtuel. 
Dessinez le polyèdre 
Choisissez Draw> Regular Polyhedron 
Sélectionnez le point de centre (0, 0, 0) du cercle en tapant les valeurs dans les boîtes de 
coordonnées . 
Tab dans la boîte DX et entrez une valeur de rayon de 30, puis appuyez sur Entrée. 
La barre d'état vous demande maintenant d'entrer une hauteur du polyèdre. 
Tab dans la boîte coordonnées dZ et entrez une valeur de hauteur de 35, et puis appuyez sur 
Entrée . 
La fenêtre Numéro de segment apparaît choisissez 18 segments 

                                              
                           
IV-6-11. Diviser le modèle par symétrie 
Ce modèle tel que construit est symétrique par rapport au plan yz. Maintenant, divisez 
le modèle le long du plan yz. 
Cliquez 3D Modeler> Boolean> Split 
La fenêtre de partage apparaît. 
Sélectionner YZ plan de séparation et le côté positif  
Cliquez sur OK pour fractionner l'ensemble du modèle. 
Votre modèle final devrait ressembler à celui présenté ci-dessous: 
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 IV-6 -12.Affecter une limite de rayonnement l’Air 
Sélectionnez le Airvol en cliquant dessus dans la Modeler 3D 
Cliquez sur HFSS du  menu, Boundaries>Assign>Radiation. 
Cliquez  OK pour accepté le nom par défaut  Rad1  
Le résultat est illustré ci-dessous : 

 
 
Attribuer un  champ E parfait pour la base du polydère HFSS >Boundaries>Assign>Perfect E. 
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IV-6 -13.Assigner un champ H  parfait à Annular_Feed_Ring 
Selectionnez  annular_rng.  
Dans le menu HFSS, cliquez Boundaries>Assign>Perfect H. 
La fenêtre de la frontière Parfait H apparaît. 
Cliquez sur OK pour accepter le nom PerfH1 par défaut et appliquer le H parfaite 
limite. 
La condition limite H parfaite résultant est affectée à la face de annular_rng de l'objet, comme 
illustré ci-dessous: 

 
 

IV-6 -14.Attribuer une frontière symétrique au modèle 
Boundaries>Assign>Symmetry. 
Sélectionner Perfect H cliquez sur ok pour accepter le nom par défaut sym1 
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IV-6 -15.Attribuer une excitation 
Cliquez sur View > Zoom In 
En mode de sélection des faces, sélectionnez le gap ou utilisez l'arborescence . Dans le menu 
HFSS, cliquez excitations> Assign> Port Lumped. 
Dans Lumped Port:General, entrez les valeurs indiquées ci-dessous, et puis cliquez sur 
Suivant : 
Nom : LumpPort1  
Résistance 100 Ohms de la résistance ou impédance réelle de port. 
Réactance 0 Ohms La réactance, 
Dans le Port Lumped: Modes étape, cliquez dans la liste de la ligne d'intégration, 
puis sélectionnez New Line. 
L'assistant Port Lumped disparaît pendant que vous dessinez le vecteur. 
Définissez la ligne d'intégration 
Sélectionner le point de départ en cliquant sur  (0,5.8, 0). 
Sélectionner le point d'extrémité  (0,4.8, 0). 
Acceptez Zpi comme méthode de calcul des caractéristique d’impédance, puis cliquez sur 
Terminer.On obtient ce ci : 
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IV-6 -16.Configuration de la solution  
Pour ajouter une configuration de solution à la conception: 
Cliquez sur HFSS>Analysis>Add Solution Setup. 
La boîte de dialogue de configuration de la solution apparaît: 

                     
 
IV -6-17.Ajouter  une fréquence de balayage 
Ajouter un balayage de fréquence à la configuration de la solution 
Pour générer une solution à travers une gamme de fréquences, ajoutez une fréquence de 
balayage à la configuration de la solution. HFSS effectue le balayage après l'adaptation de la  
solution. 
Cliquez sur HFSS>Analysis Setup>Add Sweep. 
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Sélectionner sweep type: fast 
Type: Linear Step 
Entrez les valeurs : 
Start 2.5 GHz 
Stop 5 GHz 
Step Size 0.01 GHz 
 
IV -6-18.Validation du model 
HFSS>validation check 

 
 
IV-6-19.Analyse du model 
HFSS>analyse all 
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IV-6 -20.Créer un rapport du paramètre S11 
HFSS>Results>Create Modal Solution Data Report>Rectangular plot 

Cliquez sur New Report 
On aura ce graphe : 
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IV-6 -21.Créer un rapport du paramètre Z 
HFSS>Results>Create Modal Solution Data Report>Rectangular plot 
Choisissez : 
Category : Z Parameter 
Quantity : Z (LumpedPort1, LumpedPort1) 
Function : re 
Cliquez sur New Report  
Puis cliquez add pour rajouter le graphe de la partie imaginaire  
Et choisissez : 
Category : Z Parameter 
Quantity : Z (LumpedPort1, LumpedPort1) 
Function : im 
On aura les deux graphes comme illustré ci-dessous : 
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IV-6 -22.Créer un rapport du champ E 
HFSS>Fields>Plot Fields>E>Mag_E. 
Puis cliquez sur done. 

 
Notre rapport ressemblera a ce ci : 
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IV-6 -23.Créer une animation du champ E sur le model 
Selectionnez Mag_E1 de l’arborescence   
Cliquez HFSS>Fields>Animate. 
 

 
 
IV-7.Antenne Cornet 
IV-7-1.Ouvrir un nouveau projet 
Aller vers File>New 
Puis sélectionner Insert HFSS Design 
IV-7-2.Le type de solution 
Sélectionner HFSS>Solution type  
Choisir Driven Modal 
Cliquez sur OK 
IV-7-3.Choisir l’unité de mesure 
Modeler>units sélectionner  in 
Pour le matériau laisser le par défaut Vaccum. 
IV-7-4.Créer le model 

� Créer le guide d’onde 
Draw>Cylinder 
En utilisant les champs de saisie des coordonnées, entrez la position du cylindre 
X: 0.0, Y: 0.0, Z: 0.0 Appuyez sur la touche Entrée 
À l'aide des champs de saisie des coordonnées, entrez le rayon: 
dX: 0.838, dY: 0.0, dZ: 0.0 Appuyez sur la touche Entrée  
Utiliser les champs de saisie des coordonnées, entrez la hauteur: 
dX: 0.0, dY: 0.0, dZ: 3.0 Appuyez sur la touche Entrée  
Nommé :Waveguide cliquez sur Ok 
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� Déplacer le système des coordonnées 
Modeler>cordinate System>create>relative CS>Offset 
À l'aide des champs de saisie de coordonnées, entrez l’origine 
dX: 0.0, dY: 0.0, dZ: 3.0 Appuyez sur la touche Entrée  
Créer la région de transition 
� Créer le guide d’onde de transition 
Draw>Cône 
En utilisant les champs de saisie des coordonnées, entrez la position du cone 
X: 0.0, Y: 0.0, Z: 0.0 Appuyez sur la touche Entrée 
À l'aide des champs de saisie des coordonnées, entrez le petit rayon: 
dX: 0.838, dY: 0.0, dZ: 0.0 Appuyez sur la touche Entrée  
À l'aide des champs de saisie des coordonnées, entrez le petit rayon: 
dX: 1.547, dY: 0.0, dZ: 0.0 Appuyez sur la touche Entrée  
Utiliser les champs de saisie des coordonnées, entrez la hauteur: 
dX: 0.0, dY: 0.0, dZ: 1.227 Appuyez sur la touche Entrée  
Nommé :Taper cliquez sur Ok 
� Déplacer le system des coordonnées 
Modeler>cordinate System>create>relative CS>Offset 
À l'aide des champs de saisie de coordonnées, entrez l’origine 
dX: 0.0, dY: 0.0, dZ: 1.227 Appuyez sur la touche Entrée  
� Créer le Throat 
Draw>Cylinder 
En utilisant les champs de saisie des coordonnées, entrez la position du cylindre 
X: 0.0, Y: 0.0, Z: 0.0 Appuyez sur la touche Entrée 
À l'aide des champs de saisie des coordonnées, entrez le rayon: 
dX: 1.547, dY: 0.0, dZ: 0.0 Appuyez sur la touche Entrée  
Utiliser les champs de saisie des coordonnées, entrez la hauteur: 
dX: 0.0, dY: 0.0, dZ: 3.236 Appuyez sur la touche Entrée  
Nommé : Thorat cliquez sur Ok 

� Sélectionnez tout les objets et renommer : Horn Air 
� Créer le Horn Wall 

Draw>Cylinder 
En utilisant les champs de saisie des coordonnées, entrez la position du cylindre 
X: 0.0, Y: 0.0, Z: 0.0 Appuyez sur la touche Entrée 
À l'aide des champs de saisie de coordonnées, entrez le rayon: 
dX: 1.647, dY: 0.0, dZ: 0.0 Appuyez sur la touche Entrée  
Utiliser les champs de saisie de coordonnées, entrez la hauteur: 
dX: 0.0, dY: 0.0, dZ: 7.463 Appuyez sur la touche Entrée  
Nommé : Horn cliquez sur Ok 
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� Créer Air 
Draw>Cylinder 
En utilisant les champs de saisie de coordonnées, entrez la position du cylindre
X: 0.0, Y: 0.0, Z: 0.0 Appuyez sur la touche Entrée
À l'aide des champs de saisie de
dX: 2.2, dY: 0.0, dZ: 0.0 Appuyez sur la touche Entrée
Utiliser les champs de saisie de
dX: 0.0, dY: 0.0, dZ: 8.2 Appuyez sur la touche Entrée 
Nommé : Air cliquez sur Ok 
IV-7-5.Les conditions aux limites
Sélectionnez Air  
Du menu cliquez sur HFSS>Boundaries>Assign>Radiation
Accepter le nom par défaut : Rad1

 
 

 
� Créer un port 
Draw>Circle 
En utilisant les champs de saisie de
X: 0.0, Y: 0,0, Z: 0.0 Appuyez sur la touche Entrée
À l'aide des champs de saisie de
Dx : 0.838, dy: 0.0, dZ: 0.0: Appuyez sur la touche Entrée
Définir le nom:P1 
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En utilisant les champs de saisie de coordonnées, entrez la position du cylindre
X: 0.0, Y: 0.0, Z: 0.0 Appuyez sur la touche Entrée 
À l'aide des champs de saisie des coordonnées, entrez le rayon: 
X: 2.2, dY: 0.0, dZ: 0.0 Appuyez sur la touche Entrée  

Utiliser les champs de saisie des coordonnées, entrez la hauteur: 
dX: 0.0, dY: 0.0, dZ: 8.2 Appuyez sur la touche Entrée  

5.Les conditions aux limites 

Du menu cliquez sur HFSS>Boundaries>Assign>Radiation 
: Rad1 

En utilisant les champs de saisie des coordonnées, entrez la position centrale
X: 0.0, Y: 0,0, Z: 0.0 Appuyez sur la touche Entrée 

e des champs de saisie des coordonnées, entrez le rayon du cercle: 
0.838, dy: 0.0, dZ: 0.0: Appuyez sur la touche Entrée 
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En utilisant les champs de saisie de coordonnées, entrez la position du cylindre 

 

coordonnées, entrez la position centrale 
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IV-7-6.Attribuer une excitation au port
HFSS>Excitation>Assign>Wave Port
Wave Port: General 
Name: P1 
Cliquez sur Suivant 
Number of modes: 2 
Sélectionner New line 
En utilisant les champs de saisie de
X: -0.838, Y: 0,0, Z: 0.0 Appuyez sur la touche Entrée
À l'aide des champs de saisie de
Dx : 1.676, dy: 0.0, dZ: 0.0: Appuyez sur la touche Entrée
L’excitation du port est illustrée ci
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6.Attribuer une excitation au port 

HFSS>Excitation>Assign>Wave Port 

En utilisant les champs de saisie des coordonnées, entrez la position du vecteur
0.838, Y: 0,0, Z: 0.0 Appuyez sur la touche Entrée 

À l'aide des champs de saisie des coordonnées, entrez le sommet 
1.676, dy: 0.0, dZ: 0.0: Appuyez sur la touche Entrée 

L’excitation du port est illustrée ci-dessous : 
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coordonnées, entrez la position du vecteur 
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� Déplacer le système des coordonnées
Modeler>cordinate System>create>relative CS>Offset
À l'aide des champs de saisie de coordonnées, entrez l’origine
dX: 0.0, dY: 0.0, dZ: 7.463 appuyez sur la touche entrée
 
IV-7-7.Créer une configuration de la radiation
HFSS>Radiation>Insert Far Field Setup>Infinite Sphere
Entrez les données suivante: 
Name: ff_2de 
Phi: (Start: 0, Stop: 90, Step Size
Theta: (Start:-180, Stop: 180, Step
 
IV-7-8.Configuration des analyses
HFSS>Analysis Setup>Add Solution Setup
Solution Frequency: 5.0GHZ 
Maximum Number of Passes: 10
Maximum Delta S per Pass: 0.02
Cliquez sur OK 
 
IV-7-9. Validation et Analyse
HFSS >Validation Check 
HFSS >Analyse All 
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des coordonnées 
Modeler>cordinate System>create>relative CS>Offset 

champs de saisie de coordonnées, entrez l’origine 
dX: 0.0, dY: 0.0, dZ: 7.463 appuyez sur la touche entrée 

7.Créer une configuration de la radiation 
HFSS>Radiation>Insert Far Field Setup>Infinite Sphere 

Size: 90) 
, Stop: 180, Step Size: 2) 

8.Configuration des analyses 
HFSS>Analysis Setup>Add Solution Setup 

 
Maximum Number of Passes: 10 

0.02 

9. Validation et Analyse 
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IV-7-10.Créer le diagramme de rayonnement
HFSS>Results>Create Far field report>Radiation Pattern
Entrez les données figurantes sur la table ci
 

Cliquez sur new report 
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10.Créer le diagramme de rayonnement 
HFSS>Results>Create Far field report>Radiation Pattern 

sur la table ci- dessous: 
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HFSS>Results>Create Far field report>Radiation Pattern
Entrez les données figurantes sur la table ci
 

Cliquez sur new report 
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HFSS>Results>Create Far field report>Radiation Pattern 
s sur la table ci-dessous: 
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Pour la directivité  
HFSS>Results>Create Far field report>Radiation Pattern
Entrez les données figurantes sur la table ci
 

Cliquez sur new report 
 
 

 
IV-8.Conclusion 
Nous avons vue dans ce chapitre six exemples de simulations différentes comportant 
toutes les étapes à suivre pour obtenir des résultats. Ainsi nous avons at
consiste à métriser le logiciel HFSS et de pouvoir  l’utiliser à
d’études pratiques dans lesquels on aura à créer de nouvelles antennes. Mais tout 
passera par la simulation puis 
permettra d’économiser.  
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HFSS>Results>Create Far field report>Radiation Pattern 
sur la table ci-dessous : 

dans ce chapitre six exemples de simulations différentes comportant 
toutes les étapes à suivre pour obtenir des résultats. Ainsi nous avons atteint notre but qui 

HFSS et de pouvoir  l’utiliser à l’avenir  pour des  projets 
d’études pratiques dans lesquels on aura à créer de nouvelles antennes. Mais tout 
passera par la simulation puis à la réalisation, le logiciel HFSS nous facilitera la tâ

Simulation des antennes sous HFSS  2013 

 

 

 

dans ce chapitre six exemples de simulations différentes comportant chacune 
teint notre but qui 

l’avenir  pour des  projets 
d’études pratiques dans lesquels on aura à créer de nouvelles antennes. Mais tout d’abord on 

SS nous facilitera la tâche, et nous 
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Conclusion Générale  



 

Dans le cadre général de notre travail nous avons  présenté les caractéristiques des 

antennes qui sont communes à toutes les antennes tel que : le diagramme de rayonnement, le 

gain, l’impédance d’entrée… et les notions de base d’électromagnétisme, ce premier chapitre 

a un caractère fondamental, ce qui est capital afin d’être qualifié à apporter des perspectives. 

Et nous avons eu une vue d'ensemble des différents types d'antennes rencontrés dans les 

applications actuelles telle que l’antenne patch qui est au cœur du développement actuel. On a 

consacré tout un chapitre pour  définir sa structure et ses caractéristiques, les méthodes 

d’alimentations, ses avantages…etc. Elle s’intègre facilement  à toutes les surfaces par rapport 

à sa taille réduite et plane, elle présente un faible coût de fabrication. 

Dans n’importe quel domaine d’étude où on est amené à la conception  il y’a des 

paramètres qui interviennent, et qui peuvent êtres des handicapes tel que les contraintes 

financières, alors on fait appel à la simulation. 

Le rôle des outils de simulation numérique et leurs utilité dans la conception vu, qu’ils 

facilitent  la procédure .Nous avons opté pour un  logiciel de simulation des antennes qui est 

le  HFSS (High Frequency Structure Simulation) que nous avons présenté dans le troisième 

chapitre où on a décrit ses outils, ses différentes fonctionnalités, et les procédures à suivre  

pour obtenir des résultats. 

Dans le quatrième chapitre on a commencé par simuler l’antenne dipôle où on a obtenu des 

résultats satisfaisants : diagramme de rayonnement, fréquence de résonance, distribution du 

courant… etc puis l’antenne patch rectangulaire avec deux méthodes d’alimentations où les 

résultats concordaient avec ceux de la théorie. Puis l’antenne cornet qui est non moins 

importante car elle intervient dans tous les bancs de mesure d’antennes, sa simulation été de 

plus compliquée, les résultats étaient bons et nous nous sommes rendus compte du degré 

d’importance de chaque étape de la simulation. 

Et l’antenne à  résonateur diélectrique où nous avons rencontré pas mal de problèmes vu son 

design complexe sphérique en 3D, du dessin du modèle, l’attribution des matériaux, à 

l’assignement des conditions aux limites pour arriver à la fin à obtenir son diagramme de 

rayonnement. L’antenne patch à élément rayonnant triangulaire à  fentes, ayant une géométrie 

abstrus nous avons eu des difficultés à y parvenir. Mais dans l’ensemble notre objectif est 

atteint puisque nous sommes arrivés à avoir des résultats corrects. 

Le travail futur sera d’étudier d’autres logiciels de simulation tels que le CST microwave,le 

FEKO ,l’IE3D Zéland….etc et d’établir une comparaison. 
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